
 

Color Server

 

FIERY COLOR REFERENCE





          
Copyright © 2002 Electronics For Imaging, Inc. All rights reserved. 

This publication is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form or by any means for any purpose 
without express prior written consent from Electronics For Imaging, Inc., except as expressly permitted herein. Information in this document is subject to change 
without notice and does not represent a commitment on the part of Electronics For Imaging, Inc. 

The software described in this publication is furnished under license and may only be used or copied in accordance with the terms of such license. 

This product may be covered by one or more of the following U.S. Patents: 4,500,919, 4,837,722, 5,212,546, 5,343,311, 5,424,754, 5,467,446, 5,506,946, 
5,517,334, 5,537,516, 5,543,940, 5,553,200, 5,615,314, 5,619,624, 5,625,712, 5,666,436, 5,760,913, 5,818,645, 5,835,788, 5,867,179, 5,959,867, 
5,970,174, 5,982,937, 5,995,724, 6,002,795, 6,025,922, 6,041,200, 6,065,041, 6,112,665, 6,122,407, 6,134,018, 6,141,120, 6,166,821, 6,185,335, 
6,201,614, 6,215,562, 6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,238,105, 6,239,895, 6,256,108, 6,269,190, 6,289,122, 6,292,270, 
6,310,697, 6,327,047, 6,327,050, 6,327,052, RE36,947, D406,117, D416,550, D417,864, D419,185, D426,206, D439,851, D444,793

Trademarks

ColorWise, EDOX, EFI, Fiery, the Fiery logo, Fiery Driven and RIP-While-Print are registered trademarks of Electronics For Imaging, Inc. in the U.S. Patent 
and Trademark Office and/or certain other foreign jurisdictions.

The eBeam logo, the Electronics For Imaging logo, the Fiery Driven logo, the Splash logo, AutoCal, ColorCal, Command WorkStation, DocBuilder, DocBuilder 
Pro, DocStream, eBeam, EFI Color Profiler, EFI Production System, EFI ScanBuilder, Fiery X2, Fiery X2e, Fiery X2-W, Fiery X3e, Fiery X4, Fiery ZX, Fiery Z4, 
Fiery Z5, Fiery Z9, Fiery Z16, Fiery Z18, Fiery Document WorkStation, Fiery Downloader, Fiery Driver, Fiery FreeForm, Fiery Link, Fiery Prints, Fiery Print 
Calibrator, Fiery Production System, Fiery Scan, Fiery ScanBuilder, Fiery Spark, Fiery Spooler, Fiery WebInstaller, Fiery WebScan, Fiery WebSpooler, Fiery 
WebStatus, Fiery WebTools, NetWise, RIPChips, Splash, Velocity, Velocity Balance, Velocity Build, Velocity Design, Velocity Estimate, Velocity Scan, and 
VisualCal are trademarks of Electronics For Imaging, Inc.

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged.

Legal Notices 

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. 
APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED 
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 
Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence], 
product liability or otherwise), will be limited to $50. 

Restricted Rights Legends 

For defense agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at 252.227.7013. 

For civilian agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (a) through (d) of the 
commercial Computer Software Restricted Rights clause at 52.227-19 and the limitations set forth in Electronics For Imaging’s standard commercial agreement 
for this software. Unpublished rights reserved under the copyright laws of the United States. 

Part Number: 45026397



            
RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the software (“Software”) and accompanying documentation (“Documentation”) included with the Product. The 
Software is licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend 
the Software. You may, however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) you transfer to 
the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
materials, and this Agreement); (2) you retain no copies of the Software and Documentation, including copies stored on a computer; and (3) the recipient agrees 
to the terms and conditions of this Agreement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except as necessary for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to alter, disassemble, decompiler, decrypt 
or reverse engineer the Software.

Proprietary Rights

You acknowledge that the Software is proprietary to EFI and its suppliers and that title and other intellectual property rights therein remain with EFI and its 
suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.

Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.



          
Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE 
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, 
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software in any form in violation of any applicable laws or regulations of the United States or the country in 
which you obtained them.

U.S. Government Restricted Rights:

The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable.

General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with 
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404





 

Contents

                 
Introduction
Basics of color management xi

Controlling printed color xii

Maintaining printer consistency xiii

Printer gamut xiv

Color conversion xv

Chapter 1: Simple and Advanced Workflows
Workflow concepts 1-1

Short-run printing versus color proofing 1-1

RGB, CMYK, and spot colors 1-2

Desktop versus ColorWise color management 1-2

Simple workflows 1-3

Select your colors wisely 1-4

Select a short workflow 1-4

Advanced workflows 1-8

Short-run printing examples 1-8

Color proofing examples 1-14

Chapter 2: Working with Color in Applications
Working with color 2-1

Color reference pages 2-2

Office applications 2-3

Choosing colors in office applications  2-4

PostScript applications 2-5

Choosing colors in PostScript applications 2-6

Default output profile 2-8

CMYK simulation 2-8



 

viii Contents

                   
Chapter 3: Office Applications
Working with office applications 3-1

Defining colors 3-1

Working with imported files 3-1

Selecting options when printing 3-2

Output profiles 3-2

Chapter 4: Adobe Photoshop
Creating a monitor profile 4-1

Specifying color settings 4-2

Photoshop 6.x color settings 4-3

Photoshop 5.x color settings 4-5

Saving files 4-9

Saving files from Photoshop 6.x or 5.x 4-9

Advanced tips for using PostScript color management 4-12

Defining colors 4-13

Selecting options when printing 4-13

Advanced tips for printing with Photoshop PostScript color management 4-15

Chapter 5: Page Layout Applications
Working with page layout applications 5-1

Defining colors 5-1

Importing images 5-2

CMYK simulation 5-3

Adobe InDesign 1.5.2 5-3

InDesign color settings 5-3

Importing images 5-4

Selecting options when printing 5-5



 

ix Contents

             
Adobe PageMaker 7.x and 6.5 for Mac OS and Windows 5-7

PageMaker color settings 5-7

Windows version requirement 5-8

Importing images 5-8

Selecting options when printing 5-9

Optional Color Management from PageMaker 5-10

QuarkXPress 4.x for Mac OS and Windows 5-10

Importing images 5-11

Selecting options when printing 5-11

Optional Color Management from QuarkXPress 5-12

QuarkXPress 3.32 for Mac OS and Windows 5-12

Windows version requirement 5-13

Importing images 5-13

Selecting options when printing 5-13

Chapter 6: Illustration Applications
Working with illustration applications 6-1

Defining colors 6-1

Importing images 6-2

CMYK simulation 6-3

Adobe Illustrator for Windows and Mac OS 6-3

Illustrator 9.x color settings 6-3

Specifying print options 6-4

Illustrator 8.x color settings 6-6

Specifying print options 6-7

Saving files for importing into other documents 6-8

FreeHand 9.x and 8.x for Windows and Mac OS 6-9

FreeHand color settings 6-9

Defining colors 6-10

Importing images 6-10

Saving files for importing into other documents 6-12

Optional color management in FreeHand 6-12



 

x Contents

              
CorelDRAW for Windows and Mac OS 6-13

Defining colors 6-13

Importing images 6-13

Specifying print options 6-14

Saving files for importing into other documents 6-16

Optional color management in CorelDRAW 6-16

Appendix A: Desktop Color Primer
The properties of color A-1

The physics of color A-1

CIE color model A-3

Hue, saturation, and brightness A-4

Additive and subtractive color systems A-5

Printing techniques A-9

Halftone and continuous tone devices A-9

Using color effectively A-10

A few rules of thumb A-11

Color wheel A-11

Color and text A-13

Raster images and vector images A-14

Optimizing files for processing and printing A-16

Resolution of raster images A-16

Scaling A-18

Glossary

Bibliography

Index



 

xi Basics of color management

                
This manual introduces the concepts and issues associated with printing to the 
Color Server™. It outlines key workflow scenarios and provides application notes that 
explain how to print to the Color Server from popular Microsoft Windows and 
Apple Mac OS applications. This reference guide also provides basic background 
information on color theory and color management.

The Glossary at the back of this manual defines terms and concepts—for example, 
output profile—that appear throughout this manual. Color terms and concepts such 
as “RGB data,” “color space,” “spot color,” “gamut,” and “source profile” are used 
throughout this manual. If you are new to desktop color, or if any terms are unfamiliar, 
check the Glossary.

NOTE: The term “printer” is used throughout this manual to denote a supported 
printer or copier.

Basics of color management
The past several years have seen progress toward standardization in the field of digital 
color management systems. Both the Windows and Mac OS operating systems now 
support an industry standard format developed by the International Color 
Consortium (ICC). This ICC format is implemented on Windows computers in 
Image Color Matching (ICM) and on Mac OS computers in ColorSync. More and 
more software developers are also incorporating color management systems into 
high-end applications. The Color Server color management system, ColorWise®, 
supports this standard profile format.

A color management system (CMS) is a “translator” between the color space of 
the source image (for example, the monitor or a scanner) and the color space of the 
printer. The CMS uses a device-independent color space, such as CIELAB, as its 
intermediate color space. To perform its translation, the CMS needs information about 
the color space of the source image and the gamut of the printer. This information is 
provided in the form of profiles, often created by the makers of the computer monitor 
or printer. The end product of a CMS conversion is a printed document or an image 
file in the gamut of a particular printer.

Introduction
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NOTE: If color matching between your monitor and printed output is critical, calibrate 
your monitor, as well as your Color Server. For most users, predictability of printed 
color output is adequate and monitor calibration is not necessary. For information on 
monitor calibration, see your Adobe Photoshop or Adobe Illustrator documentation.

The following section provides information on controlling and managing color output 
in order to achieve predictable color results. It also discusses the basics of color 
management.

Controlling printed color
When working with color materials, whether they are presentations, illustrations, 
or complicated page designs, you make aesthetic decisions about the colors you use. 
Once you have decided on your goal, you must make the best use of the capabilities of 
your Color Server to realize your design in print. Your color printing system becomes 
an ally in this creative process to the extent that results are predictable. 

• If you designed a poster to print on the Color Server, you want the printed colors to 
match the design specification.

• If you are printing presentations on the Color Server, you want to preserve the vivid 
colors you see on your monitor.

• If you are working with color that will be printed on an offset press, you want the 
Color Server output to match other prepress proofs or PANTONE color swatch 
books.

The type of print job and the final output device—Color Server or offset press—
determine the workflow you should use to achieve the best results.

No matter what your goals are, two factors always impact color print output: printer 
consistency and the range of colors the printer can print, known as its gamut. These 
concepts are covered briefly in this chapter. Creating successful color documents and 
presentations also requires an understanding of color management software as it is 
implemented by the Color Server and on your desktop computer. Most of this chapter 
is devoted to discussing the various elements of color management that contribute to 
predictable color results.
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Maintaining printer consistency
The factors described in the following sections affect printer consistency, as well 
as color fidelity and overall output quality.

Paper stock and toner

The paper and toner used by your printer can affect printed color. For best results, 
use the supplies recommended by the manufacturer of the printer.

Maintenance

Problems such as streaking and insufficient or excessive amounts of one or more toners 
arise when a printer does not receive periodic maintenance or needs major repairs. 
In addition to having it serviced regularly, monitor the condition of your printer by 
making standard test prints at regular intervals. You can do this easily by printing the 
Color Server Test Page. Save the prints and show them to the service technician 
whenever output densities vary from the norm or other problems appear.

Calibration

Output from color printers is subject to changes in temperature and humidity, and is 
prone to drift over time, with a resulting loss in color predictability. For this reason, 
regular service visits alone do not guarantee consistent results from a printer. Where 
color accuracy and consistency are crucial, regular calibration of the Color Server and 
printer is necessary.

Calibration generates transfer curves that adjust for the difference between the actual 
toner densities (measurements) of the print device and the response expected by the 
output profile. These transfer curves are stored on the Color Server and used in 
association with output profiles to produce color output that accounts for the unique 
toner characteristics of the printer.

For information on performing calibration of the Color Server, see the Color Guide. 
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Printer gamut
Different color reproduction techniques have different color capabilities, or gamuts. 
Color transparency films have comparatively large gamuts, as do color monitors. 
The color gamut that can be produced using process inks or CMYK toners on paper is 
smaller. This is why some colors that can be displayed on a color monitor, especially 
bright saturated colors, cannot be reproduced exactly by your Color Server—nor, for 
that matter, can they be reproduced on a press using process colors. Moreover, different 
printers have different gamuts—some colors your printer can produce cannot be 
reproduced on an offset press, and vice versa. The following figure illustrates this 
concept of differing gamuts.

You must account for the gamut of your printer when designing on a color monitor. 
When printed, colors that fall outside the printer gamut are “mapped” to printable 
colors. This process, referred to as gamut mapping, takes place when color data is 
converted or adjusted to meet the gamut requirements of a printer. 

The Color Server is specially designed to perform gamut mapping at high speed with 
high-quality results. It provides these color management features automatically, using 
either built-in default settings or settings you select for a particular print job. For added 
flexibility, you can also use the Color Server color management system in combination 
with the color management systems on Windows and Mac OS computers.

Color transparency film

Other print device

RGB monitor

Offset press (white)
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Color conversion
Before you can print a color document, the color data in it must be converted to the 
gamut of the printer. Whether performed by the Color Server or a host-based CMS, 
the process of converting color data for a printer is the same: the CMS interprets RGB 
image data according to a specified source profile and adjusts both RGB and CMYK 
data according to a specified output profile, also called a destination profile by some 
color management systems.

The source profile defines the RGB color space of the image’s source—characteristics 
such as the white point, gamma, and type of phosphors used. The output profile 
defines the gamut of an output device, such as a printer. The Color Server (or the 
host-based CMS) uses a device-independent color space to translate between the 
source color space and the color space of the output device.

The Color Server allows you to specify default and override settings for the source 
color space information and the output profile information (see the Color Guide). 
When you use these settings, you do not need to use the features of other color 
management systems. Your Color Server software includes ICC profiles for use with 
other color management systems, if you choose to use them, although conflicts may 
arise when the Color Server CMS is used in conjunction with a host CMS.

You can also use color management systems to adjust color data to the gamut of an 
output device other than the one to which you are printing. This process of simulating 
another output device is commonly used for proofing jobs that will print on an offset 
press. The Color Server simulation feature is described in the Color Guide.

Input data Printed data or file

Color management system

Device-independent 
color space

Source 
profile

Output 
profile
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1-1 Workflow concepts

           
This chapter discusses color management workflows used in short-run color printing, 
as well as color proofing on the Color Server. It also gives examples of color 
management in specific desktop applications and discusses the interaction between 
those applications and ColorWise color management.

Workflow concepts
The term “workflow” is used to describe the path a job follows from its creation in a 
desktop application to final printed output. It is helpful to think of the following 
factors when describing workflows:

• Short-run printing versus color proofing for eventual output on an offset press

• RGB, CMYK, and spot color systems

• Desktop color management within an application versus color management on the 
Color Server, along with the notion that different versions of desktop applications 
handle color management differently. 

NOTE: It is important to pay close attention to the version of a particular application 
when considering the workflows in this chapter.

Short-run printing versus color proofing
Short-run color printing refers to those jobs for which the Color Server is the final 
print device. Printing jobs to the Color Server in preparation for printing on an offset 
press is referred to as color proofing. Both types of Color Server print jobs use RGB, 
CMYK, and spot colors.

• For short-run jobs, bright, saturated colors are often desirable. These are achieved by 
using the full range of colors available, referred to as the full gamut of the printer or, 
more simply, device CMYK. For short-run printing examples, see “Advanced 
workflows” on page 1-8.

• Offset jobs proofed on the Color Server require the printed colors to match those 
from another set of CMYK printing conditions. Colors that are specified for an 
offset press require CMYK simulation that is optimized for proofing on the 
printer. For color proofing examples that simulate the gamut of another digital 
printer or press standard, see “Advanced workflows” on page 1-8. 

Chapter 1:
Simple and 
Advanced 
Workflows
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RGB, CMYK, and spot colors
Colors can be defined in several different color models, the most common being 
RGB, CMYK, and the spot color matching system. Each model requires a different 
color conversion at the Color Server. These different color conversion workflows 
are as follows:

• RGB source profiles and color rendering dictionaries (CRDs) are used to map 
RGB colors through a device-independent color space to a destination space, either 
the full device gamut in a short-run printing workflow or CMYK simulation in a 
color proofing workflow.

• CMYK colors are device-dependent. In a proofing scenario, colors specified in 
prepress applications are adjusted so that the gamut of the printer simulates that 
of the press. In a short-run printing workflow, specifying CMYK colors according 
to the calibrated Color Server output eliminates the need for simulation 
during printing.

• Spot colors, such as PANTONE, are special inks manufactured to run on an offset 
printing press. Spot colors can be simulated using CMYK toners or process color 
inks. Two basic workflows exist for printing spot colors to the Color Server:

Spot Color Matching On uses color tables built in the Color Server to simulate the 
spot color with its closest CMYK equivalent. 

Spot Color Matching Off instructs the Color Server to simulate the spot color using 
CMYK equivalents defined by the spot color manufacturer. These are the same 
CMYK values used by applications that include spot color libraries. This CMYK 
combination is then printed with the CMYK Simulation setting you choose, such as 
SWOP or DIC.

Desktop versus ColorWise color management 
A desktop color management system uses ICC profiles to convert colors from one 
device gamut to another (see Appendix A). The color data is converted when it is 
passed from one application to another or when the job is sent to the printer; thus, the 
processing occurs on your computer, as opposed to the Color Server.
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Using ColorWise color management over desktop color management relieves your 
computer from having to perform additional processing. Delaying color conversions 
until the color data reaches the Color Server frees your computer so you can continue 
working, and color conversions on the Color Server are, in most cases, much faster 
than similar conversions on a host computer.

Managing most or all of your color on the Color Server can also eliminate the potential 
for undesirable color management-related conflicts, such as iterative color conversions 
and inconsistent color. The Color Server applies global corrections to specific groups of 
RGB, CMYK, and spot colors to avoid such conflicts. 

Finally, by sending RGB files instead of larger CMYK files from applications to the 
Color Server, network traffic is minimized and jobs generally print faster.

ColorWise uses ICC profiles to convert colors to the device gamut or simulate other 
devices, such as an offset printing press. ColorWise manages color conversions for all 
users printing to the Color Server from Windows and Mac OS computers. It allows 
users to follow a simple workflow with minimal intervention using robust default 
settings, while giving advanced users the control and precision they need.

The Color Server can intelligently manage the printed appearance of RGB, CMYK, 
and spot colors. You can let the Color Server manage color for most short-run color 
printing jobs without adjusting any settings.

Simple workflows
Every time you print a document containing colors that were not chosen for your 
specific device, those colors must be converted, which requires color management. 
You can define or modify colors at any stage in the workflow. Since ColorWise is 
compatible with most other color management systems, you can use the workflow 
most familiar to you.



 

11-4 Simple and Advanced Workflows
Select your colors wisely
For the colors you see on your monitor to match those on your printed output, they 
must go through color management, including precise calibration of your monitor and 
Color Server. If you are not equipped or inclined to maintain accurate monitor color 
management, you can opt for an easier approach. Determine which is more important 
to you—printed colors or monitor-displayed colors.

If displayed colors are more important, trust your eyes and your monitor. Visually 
select colors on your monitor, but be aware that colors will be optimized only for your 
monitor. When the document is opened on other monitors, the colors may look 
different. And even though printed colors may not match those on your monitor, they 
will still print to the Color Server with good results.

If printed colors are your priority, choose colors from printed samples. By using sample 
colors, you ensure your printed output remains consistent, regardless of how the colors 
appear on different monitors. Print the palette of available colors from business 
applications and select colors from the printed samples. Color reference files are 
included on the User Software CD (see page 2-2). You can also print color charts from 
the Control Panel and select colors by name or number from the printed samples. 
Advanced applications allow you to define colors in the easier-to-control spot and 
CMYK color spaces. For more advice on color selection, see Chapter 2.

NOTE: No matter which workflow most closely matches your own, calibrate your 
Color Server regularly (see the Color Guide).

Select a short workflow
Every time colors are converted, performance and color accuracy are affected. 
Therefore, a workflow with a minimum number of steps minimizes the risk of error.

Workflow 1 using ColorWise calibration—minimal workflow

A minimal color workflow requires that you calibrate the Color Server. Select from 
printed colors, as described earlier, and set the CMYK Simulation option to None, 
since simulation is not necessary when colors are already defined using CMYK values 
optimized for your calibrated Color Server.
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NOTE: CMYK Simulation set to None is also useful when you want to prepare an 
output profile of your calibrated Color Server or when you use less efficient color 
management from the desktop (such as ColorSync or ICM). 

In this workflow, colors are modified only at the calibration stage, as indicated by the 
black box in the following diagram.

While this workflow lends some control over the color quality produced by the 
Color Server, consider additional ColorWise color management, as described in the 
following section.

Workflow 2 using ColorWise color management—standard workflow

The Color Server is highly optimized for the specific printer it supports, and 
ColorWise addresses many issues unique to your printer, including screens, individual 
toner response, interactions among toners, natural smoothness of blends, and the 
capability to render spot and custom colors. The Color Server distinguishes text and 
graphics from image elements, so the black channel information is preserved while 
parameters used for CMYK color separations are maintained.

Conventional color management systems typically address only color conversions, and 
they occupy your computer processor. When you use ColorWise, jobs leave your 
computer faster to be processed more quickly on the Color Server.

The recommended standard color workflow (indicated by the black boxes in the 
following diagram) uses ColorWise calibration and color management.

Workflow 1—Colors you define in an application Colors output from the Color Server

Application 
CMS

File format Printer driver  ColorWise 
CMS

 ColorWise 
calibration

Workflow 2—Colors you define in an application Colors output from the Color Server

Application 
CMS

File format Printer driver  ColorWise 
CMS

 ColorWise 
calibration
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The Color Server comes into play near the end of the color workflow. To ensure the 
colors you selected reach the Color Server and ColorWise in a usable form, bypass any 
color management from applications and printer drivers. Keep in mind, however, that 
ColorWise fully supports color management from applications and printer drivers (see 
“Advanced workflows” on page 1-8).

You must print with the CMYK Simulation print option set to match the CMYK 
color space used in the application to select the colors. Any CMYK Simulation setting 
(except Match Copy) applies calibration, so the response of the printer will appear to 
be stable.

The recommended values for CMYK Simulation are SWOP in the U.S., Euroscale in 
Europe, and DIC in Japan—choices that respect the color standard for each region. 
If colors have been selected specifically for your calibrated Color Server, set CMYK 
Simulation to None.

For a list and descriptions of ColorWise print options that affect CMYK, RGB, spot, 
and other colors, see the Color Guide.

Workflow 3 bypassing ColorWise—not recommended

Bypassing ColorWise color management, while a possibility, is not a recommended 
workflow. When you bypass ColorWise, you must choose colors using only CMYK 
formulas designed specifically for your printer, and you must print with the CMYK 
Simulation option set to Match Copy, if it is available for your Color Server. The 
Color Server still prints pages using your PostScript files, and drives your printer and 
its accessories, but it does not perform CMYK color transformation, nor does it 
consider calibration data. Calibration is necessary for consistent output, since the color 
response from your printer varies significantly depending on wear, heat, humidity, 
and service. 
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The following diagram indicates that no modifications are made to colors in 
this workflow.

Turn off color management in your application

Generally, when printing to the Color Server, it is best to disable color management 
in the application to ensure the Color Server receives color data properly and prints 
it accurately.

Save your files using color-safe settings

You can take the following additional steps to ensure color accuracy.

• When saving EPS files, do not include PostScript Color Management information. 
This minimizes the risk of conflicting data and multiple color conversions. 
PostScript Color Management causes your CMYK and RGB colors to be interpreted 
by the Color Server as though they were supplied in the Lab color space and, as a 
result, processed by CRDs, rather than your simulation settings.

• Include ICC color information in files. ColorWise does not conflict with this 
information, and such data is useful for identifying the specific color space used by 
your files.

• Do not include halftone and transfer functions.

• Turn off color management in the printer driver. 

On Windows computers, if the printer driver offers Image Color Matching options, 
select Printer Image Color Matching.

On Mac OS computers, set the printer driver to include no color management 
commands at print time (see the Color Guide). 

Workflow 3—Colors you define in an application Colors output from the Color Server

Application 
CMS

File format Printer driver  ColorWise 
CMS

 ColorWise 
calibration
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Advanced workflows
The following sections present advanced color management workflow examples for 
three short-run printing and three color proofing situations. Each workflow example 
consists of a brief description, steps for creating and manipulating the files, a list of the 
ColorWise settings used in the example, and a table that summarizes the workflow.

NOTE: These examples reference specific software applications that illustrate image 
editing, illustration, page layout, and business/office applications—Adobe Photoshop, 
Adobe Illustrator, QuarkXPress, and Microsoft PowerPoint, respectively.

Short-run printing examples
The following examples illustrate short-run printing on the Color Server.

Photoshop RGB workflow

This short-run workflow of printing an RGB image from Photoshop is one of the 
simplest color workflows. In it, RGB data is sent from the application, through the 
printer driver, to the Color Server. The RGB-to-CMYK conversion takes place on the 
Color Server using a CRD rather than the application. Use the settings illustrated in 
this workflow for printing photographs and artwork.

This document could be created as follows:

• Create an RGB image in Photoshop.

• Print the file directly to the Color Server. 

For recommended print settings from Photoshop, see Chapter 4. 

• Use ColorWise to convert the RGB image to device CMYK (the full gamut of 
the printer).
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The ColorWise settings used in this example are:

• RGB Source Profile set to EFIRGB or another RGB source definition

• Rendering Style set to Photographic

• RGB Separation set to Output

The following diagram indicates the steps for this particular workflow in black.

Photoshop RGB workflow

Photoshop Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

(Mac OS-Only)
Black and White
Color/Grayscale

ColorSync Color Matching
PostScript Color Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.

Convert Press CMYK to Custom Sim.
Select Device CMYK Sim.: None
Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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Photoshop RGB with Illustrator and QuarkXPress CMYK and spot colors

This workflow involves short-run printing of a complex page layout with images 
saved in Photoshop, illustrations created in Illustrator, and spot colors. A Photoshop 
image is saved in an RGB color space using the EPS file format. Illustrator artwork 
contains objects defined as CMYK and as spot colors selected from printed output, 
and they are saved using the Illustrator EPS file format. After all the individual objects 
are imported into QuarkXPress, additional design elements in QuarkXPress are 
colored using CMYK process colors or spot colors. Use the settings illustrated in this 
workflow for printing brochures, newsletters, and other layouts.

NOTE: When you place CMYK colors in a document, select them from printed output 
(see page 1-4).

This document could be created as follows:

• Create an RGB image in Photoshop and save it as Photoshop EPS. 

• Create a graphic in Illustrator using CMYK and spot colors and save as Illustrator 
EPS. 

• Use CMYK colors and a spot color in a QuarkXPress document. 

• Import the Illustrator EPS into QuarkXPress and place the Photoshop EPS image. 

• Print the QuarkXPress document to the Color Server. 

• Use ColorWise to convert the RGB image to device CMYK, adjust the process 
colors for short-run printing, and match the spot colors using the full device gamut. 
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The ColorWise settings used in this example are:

• RGB Source Profile set to EFIRGB or another RGB source definition

• Rendering Style set to Photographic

• RGB Separation set to Output

• CMYK Simulation set to None

• Spot Color Matching set to On

The following diagram indicates the steps for this particular workflow in black.

Photoshop RGB workflow with Illustrator, QuarkXPress CMYK, and spot colors

Photoshop Illustrator QuarkXPress Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

Read Embedded Profile
Define RGB Colors

Define CMYK Colors
Define spot Colors

Convert RGB to CMYK
Convert spot to CMYK 
Embed Source Profile

Select Destination Profile
Export as TIFF
Save as EPS

Print

Read Embedded Profile
Define RGB Colors

Define CMYK Colors
Define spot Colors

Convert RGB to CMYK
Convert CMYK to CMYK 
Convert spot to CMYK
Embed Source Profile

Select Destination Profile
Export as TIFF
Save as EPS

Print

(Mac OS-Only)
Black and White
Color/Grayscale
ColorSync Color 

Matching
PostScript Color 

Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.
Convert Press CMYK to Custom Sim.

Select Device CMYK Simulation: None
Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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Photoshop RGB with Illustrator CMYK and spot colors and PowerPoint RGB

This workflow involves short-run printing of a complex presentation document with 
images saved in Photoshop, illustrations created in Illustrator, and spot colors. 
All elements are imported into PowerPoint for output.

This document could be created as follows:

• Create an RGB image in Photoshop and save it as Photoshop EPS. 

• Create a graphic in Illustrator using CMYK colors and a spot color and save as 
Illustrator EPS. 

• Create a presentation in PowerPoint using RGB colors. 

• Import the Illustrator EPS graphic into the PowerPoint presentation and place the 
Photoshop EPS image. 

• Print the PowerPoint document to the Color Server. 

• Use ColorWise to convert the PowerPoint RGB colors and Photoshop RGB image 
to device CMYK, adjust the process colors for more saturated short-run printing, 
and match the spot colors using the full device gamut.
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The ColorWise settings used in this example are:

• RGB Source Profile set to EFIRGB or another RGB source definition

• Rendering Style set to Presentation

• RGB Separation set to Output

• CMYK Simulation set to None

• Spot Color Matching set to On

The following diagram indicates the steps for this particular workflow in black.

Photoshop RGB and Illustrator CMYK and spot colors in PowerPoint RGB workflow

Photoshop Illustrator PowerPoint Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

Read Embedded Profile
Define RGB Colors

Define CMYK Colors
Define spot colors

Convert RGB to CMYK
Convert spot to CMYK 
Embed Source Profile

Select Destination Profile
Export as TIFF
Save as EPS

Print

Define RGB Colors
Convert CMYK to RGB 

Print

(Mac OS-Only)
Black and White
Color/Grayscale
ColorSync Color 

Matching
PostScript Color 

Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.
Convert Press CMYK to Custom Sim.

Select Device CMYK Simulation: None
Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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Color proofing examples
The following examples illustrate methods for simulating the output from another 
printing system, such as an offset press. Each of the proofing examples uses an ICC 
profile to describe the destination color space. While some examples use simulation 
profiles built into the Color Server, others use ColorWise Pro Tools (see the Color 
Guide) to download custom ICC output profiles to the Color Server for use as 
simulation profiles. 

Photoshop 5.x RGB-to-CMYK conversion using a custom ICC profile

This workflow is useful for prepress environments that have integrated ICC color 
management and profiles for the presses they use. In this example, an image in 
Photoshop 5.x is converted from RGB to CMYK using the Photoshop ICC color 
conversion features in the CMYK Setup option. Using the Simulation settings 
available in ColorWise, the CMYK image is printed to the Color Server, and the 
output is made to appear as if it were printed on an offset press. For more information 
on CMYK Setup, see your Photoshop 5.x documentation.

This document could be created as follows:

• In Photoshop 5.x, set CMYK Model in CMYK Setup to ICC. 

• In the Profile menu, select an ICC profile for the desired offset press. Click OK. 

• Open an RGB image. Select Mode >CMYK Color from the Image menu. 

• Save the image in any file format. 

• Print directly to the Color Server. 

• Use ColorWise Pro Tools to select a simulation profile or download a custom 
ICC profile to the Color Server for use as a CMYK Simulation Profile. 
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The ColorWise settings used in this example are:

• CMYK Simulation Profile set to the desired press standard or the corresponding 
custom simulation (Simulation 1-10) if you downloaded your profile with 
ColorWise Pro Tools

• CMYK Simulation Method set to Full (Source GCR)

The following diagram indicates the steps for this particular workflow in black.

Photoshop RGB-to-CMYK workflow using ICC profile

Photoshop 5.x Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

(Mac OS-Only)
Black and White
Color/Grayscale

ColorSync Color Matching
PostScript Color Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.

Convert Press CMYK to Custom Sim.
Select Device CMYK Simulation: None

Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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Photoshop 5.x Built-in RGB-to-CMYK workflow

This workflow is useful for prepress environments that have not integrated ICC color 
management and do not have profiles for the presses they use. In this example, an 
image is converted from RGB to CMYK using the Photoshop 5.x Built-in color 
conversion features in the CMYK Setup option. Using the Simulation settings 
available in ColorWise, the CMYK image is printed to the Color Server, and the 
output made to appear as if it were printed on an offset press. For more information on 
CMYK Setup, see your Photoshop 5.x documentation.

This document could be created as follows:

• Select the Built-in option from CMYK Setup in Photoshop 5.x Color Settings.

• Adjust the Ink Options and Separation Options to match your offset press.

• Select the Tables option in CMYK Setup and click Save.

This saves your settings as a CMYK ICC profile you will later download to the 
Color Server as a custom simulation profile. 

• Select the Built-in option in CMYK Setup again and click OK.

• Start ColorWise Pro Tools and download your new CMYK ICC profile to the 
Color Server as a custom Simulation profile.

For the Appear in Driver as option in Profile Settings, select Simulation-1. 
For more information on downloading profiles, see the Color Guide.

• Open an RGB image in Photoshop 5.x. Select Mode>CMYK Color from the 
Image menu. Save the image as Photoshop EPS.

• Print the image directly to the Color Server and choose Simulation-1 as the 
CMYK Simulation Profile setting.
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The ColorWise settings used in this example are:

• CMYK Simulation Profile set to Simulation-1

• CMYK Simulation Method set to Full

The following diagram indicates the steps for this particular workflow in black.

Photoshop5.x RGB-to-CMYK workflow

Photoshop 5.x Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

(Mac OS-Only)
Black and White
Color/Grayscale

ColorSync Color Matching
PostScript Color Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.

Convert Press CMYK to Custom Sim.
Select Device CMYK Simulation: None

Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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Photoshop RGB and QuarkXPress CMYK

This workflow exemplifies the use of the RGB Separation feature of ColorWise. An 
RGB image, originally saved in Photoshop, is printed to the Color Server from 
QuarkXPress. To simulate how the RGB image would print on an offset press, the 
RGB Separation feature of ColorWise is set to Simulation. This workflow—useful for 
proofing brochures, newsletters, and other layouts—allows you to maintain 
consistency by using the source RGB file for multiple purposes.

This document could be created as follows:

• Create an RGB image in Photoshop and save it as Photoshop EPS.

• Place the EPS image in a QuarkXPress document. 

• Create several process-colored page elements alongside the image and print.

• Use ColorWise to convert the RGB image to simulated press CMYK and adjust the 
process colors for proofing to the device.
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The ColorWise settings used in this example are:

• RGB Source Profile set to EFIRGB or another RGB source definition

• Rendering Style set to Photographic

• RGB Separation set to Simulation

• CMYK Simulation Profile set to SWOP

• CMYK Simulation Method set to Full (Source GCR)

The following diagram indicates the steps for this particular workflow in black.

Photoshop RGB and QuarkXPress CMYK workflow

Photoshop QuarkXPress Printer driver ColorWise 
print options

Read Embedded Profiles
Define RGB Source

Embed Source Profiles
Convert RGB to CMYK

Convert CMYK to CMYK
Select RGB Mode

Select CMYK Mode
Select Destination Profile

Save as TIFF
Save as EPS
Save as JPEG

Print

Read Embedded Profile
Define RGB Colors

Define CMYK Colors
Define spot Colors

Convert RGB to CMYK
Convert CMYK to CMYK
Convert spot to CMYK
Embed Source Profile

Select Destination Profile
Export as TIFF
Save as EPS

Print

(Mac OS-Only)
Black and White
Color/Grayscale

ColorSync Color Matching
PostScript Color Matching

Define RGB Source
Select RGB Source: None

Select Rendering Style (CRD)
Select RGB Separation: Output

Select RGB Separation: Simulation
Convert Press CMYK to Press Sim.

Convert Press CMYK to Custom Sim.
Select Device CMYK Simulation: None

Turn Spot Color Matching On
Turn Spot Color Matching Off

Select Output Profile
Select Custom Output Profile
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This chapter provides guidelines for defining colors in your documents to produce the 
results you want. The following topics are covered:

• Factors affecting how you work with color

• Choosing colors in applications that rely on GDI (Graphics Device Interface) 
or QuickDraw to communicate data to the printer driver, such as presentation and 
word processing applications

• Choosing colors in applications that have the ability to write their own PostScript, 
such as some page layout, illustration, and pixel-editing applications

Working with color
The two main factors that influence how you work with color in the creation of 
documents are the applications you use and the Color Server. Applications vary in the 
methods they provide for choosing colors and in the way they transmit color data to 
the Color Server. 

• Office applications, such as presentation software, spreadsheets, and word processing 
programs, use the RGB color model. They typically transmit only RGB data to the 
Color Server.

• Illustration applications use both the RGB and CMYK color models but typically 
transmit only CMYK data to the Color Server.

• Pixel-editing applications use both the RGB and CMYK color models. They also 
transmit both RGB and CMYK data to the Color Server.

Chapter 2:
Working 
with Color 
in Applications



22-2 Working with Color in Applications
The type of printing you plan for the document—short-run color printing on the 
Color Server versus color proofing for eventual printing on an offset press—determines 
the way you define colors, as well as the print option settings you choose.

• For short-run color printing on the Color Server, use any application and define 
colors in either RGB or CMYK. If your application supports it, you can also choose 
colors from the PANTONE color library. Placed images may be limited to the RGB 
color space. Choose the appropriate settings for print options affecting color output 
(see the Color Guide). 

• For color proofing, use an application that writes its own PostScript. Define colors in 
RGB or CMYK, or choose colors from the PANTONE color library. Placed images 
can also be defined in RGB or CMYK. Choose the appropriate settings for print 
options affecting color output (see the Color Guide).

NOTE: The Color Server allows you to use RGB or CMYK data when printing proofs 
for an offset press run. However, sending data to an imagesetter most often requires 
CMYK data.

Color reference pages
Your Color Server user software includes several types of color reference pages that 
allow you to see the range of colors that can be printed on your printer. For predictable 
color, use the color reference pages when defining the colors in your document.

• RGB Color Reference—a Microsoft Word file and a Microsoft PowerPoint file that 
allow you to view the colors available in the standard palettes of office applications 
and see how those colors print on the Color Server (see page 2-4).

• CMYK Color Reference—an 11-page downloadable PostScript file of CMYK color 
patches (see page 2-7). 

• PANTONE Coated Color Reference—a 19-page downloadable PostScript file of 
color patches showing CMYK equivalents of PANTONE Coated colors. This file 
prints differently depending on the setting of the Spot Color Matching option 
(see page 2-7). 

In addition, you can print RGB, CMY, and PANTONE color charts from the 
Color Server Control Panel.
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Office applications 
The Color Server must receive PostScript instructions to print an image or a 
document. Many applications do not create these PostScript instructions, relying on 
the printer driver to create them. Included in this category are most word processing, 
spreadsheet, and presentation graphics applications. These applications use Windows 
Graphics Device Interface (GDI) to display and print when running Windows, and 
Apple QuickDraw to display and print when running Mac OS. We refer to these GDI 
and QuickDraw applications as “office applications.”

All office applications handle color similarly, using the same RGB color model used for 
the color monitor. Most office applications allow you to choose colors from a palette of 
preselected colors; some allow you to add new colors to the palette using a color picker. 
Although some applications allow you to specify color using the CMY, HSL, and HSV 
color models, these applications always send RGB color data to the Color Server. (An 
exception to this is a CMYK EPS file placed in the document, which is sent as 
CMYK data.)

Consider the following when working with color in office applications:

• The range of colors that can be displayed in RGB on your monitor is much larger 
than the range of colors that can be printed on your printer. When you print the 
document, out-of-gamut RGB colors are mapped to the colors your printer can 
produce.

• Office applications send only RGB data to the Color Server. You control the 
rendering style of the color conversion with your selection of a CRD.

Each CRD uses a different color rendering style and, therefore, has a different way of 
mapping unprintable colors to the color gamut of your printer. For more 
information on color rendering styles, see the Color Guide. 
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Choosing colors in office applications
Two RGB color reference pages, a Microsoft Word file and a Microsoft PowerPoint file, 
are provided with your Color Server user software. You can print these files using 
different CRDs to see how the colors appear when printed to the Color Server. For 
best results, print the color reference page using the same print options you plan to use 
for your final document. Select the colors you want to use from the printed version of 
the RGB color reference page and use those colors in your document.

RGB Color Reference (Microsoft PowerPoint)
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PostScript applications
Most applications used for illustration, pixel editing, and page layout can create the 
PostScript information they send to a PostScript printer or save in PostScript files. 
Illustrator, Photoshop, PageMaker, QuarkXPress, and Macromedia FreeHand are 
all PostScript applications.

PostScript applications work with color in many different ways. Most allow you to 
choose process colors (by entering percentages for cyan, magenta, yellow, and black), 
as well as named colors from a spot color system, such as PANTONE. When you 
print composites, these applications send process-color equivalents for named spot 
colors to the Color Server. In some applications, you can also choose colors using the 
RGB, HSB, HSL, or other color models.

Generally, PostScript applications send color information to the Color Server as 
CMYK data. An exception to this is an RGB image placed in the document, which is 
sent directly to the Color Server (unless you specify special color management settings 
in the application.) In addition, some PostScript applications that allow you to define 
colors in RGB or other color models can also send data to the Color Server in those 
color spaces.

Color controls in PostScript applications are typically designed for printing on an 
offset press, and some adjustments are required for printing to the Color Server. 
Displayed versions of colors you choose in these applications may not match 
Color Server output exactly, and named colors may not print accurately on the 
Color Server, since these colors typically require custom inks. 
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Choosing colors in PostScript applications
With PostScript applications, you can create colors using any of the color models 
supported by the application. All PostScript applications support CMYK; some also 
support RGB and other color models based on monitor display values. PostScript 
applications also allow you to choose named colors using one or more color libraries, 
such as PANTONE (see page 2-7).

Use swatch color matching to ensure predictable color printing results with 
the Color Server or to match your Color Server output to colors produced by 
other printers. 

Swatch color matching

Your Color Server user software includes several color reference pages (see page 2-2). 
By choosing colors from these reference pages, you ensure that you get the same color 
from your device. For best results, calibrate the Color Server before printing the 
reference pages. 

NOTE: Swatch color matching does not match monitor colors to printed colors. 
For this, you must use a color management system and calibrate your monitor.
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Using the CMYK Color Reference

The CMYK Color Reference included with your Color Server user software allows you 
to see how various cyan, magenta, yellow, and black combinations look when printed 
on your printer.

To print the CMYK Color Reference, download the file to the Color Server. 
The printed pages display groups of color patches in graduated combinations of 
yellow, magenta, and cyan, and smaller patches that include 25%, 50%, and 75% 
black. Refer to these pages to pick colors and specify process color values in your 
application. For the location of the file on the User Software CD, see the User Software 
Installation Guide.

PANTONE Coated Color Reference

The PANTONE Coated Color Reference included with your Color Server user 
software can help ensure predictable results with colors chosen from the PANTONE 
color library. 

CMYK Color Reference
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The information printed by the PANTONE Coated Color Reference depends on the 
Spot Color Matching setting. 

• On—Prints swatches of the closest CMYK equivalents of PANTONE colors your 
printer can produce. The equivalent PANTONE color name/number is printed 
below each swatch.

• Off—Prints swatches of the CMYK equivalents of PANTONE colors as defined 
by PANTONE. (These are the same CMYK values defined in applications that 
include PANTONE libraries.) The CMYK values used to produce the color, as well 
as the PANTONE color name/number, are printed below each swatch.

To print the PANTONE Coated Color Reference, download the file to the 
Color Server. For the location of the file on the User Software CD, see the User 
Software Installation Guide. If the default Spot Color Matching setting on the 
Color Server is not the setting you want to use for printing the PANTONE colors, 
download the file to the Hold queue. Then override the Spot Color Matching setting 
using a job management utility, such as Command WorkStation (see the Job 
Management Guide).

Default output profile
The default output profile consists of both a profile for the printer supported by the 
Color Server and a calibration target that describes the expected behavior of the 
printer. For more information on output profiles, see the Color Guide. 

In certain cases, you may want to customize the default output profile to 
achieve particular color effects (see the Color Guide). When you do so, the new 
customized output profile is applied to all data in the print job. You can also use 
ColorWise Pro Tools to download your own output profile to the Color Server (see 
the Color Guide). Downloaded output profiles are at first associated with the default 
calibration target.

CMYK simulation
If you use the Color Server to print proofs for an offset press job or simulate another 
printer, choose the appropriate CMYK Simulation Profile and CMYK Simulation 
Method print option settings (see the Color Guide). 
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The ColorWise color management system provides complete color management for 
jobs printed from office applications. This chapter provides instructions for printing 
color documents from GDI (Graphics Device Interface) and QuickDraw 
applications, such as presentation, spreadsheet, and word processing applications. 
You can use these instructions with the Microsoft Office applications.

Working with office applications
Before printing from these applications, make sure the appropriate printer driver and 
the Color Server PPD are installed on your computer, as described in the User Software 
Installation Guide. 

Defining colors
Office applications use the RGB color model. For instructions on defining colors, 
see “Choosing colors in office applications” on page 2-4.

The only way to use CMYK or PANTONE colors is to define them in EPS files with 
an illustration or page layout application, and then place these files in Office 
documents. Colors in EPS files are preserved until they reach the Color Server 
(assuming no PostScript Color Management information was included.)

Office applications lack finesse when displaying EPS files, so use these files only when 
RGB colors are impractical in your specific workflow. EPS files are useful when using 
large or complex images that must be printed at full resolution or exceed the memory 
allocation of some MS Office applications.

Working with imported files
Although your application may allow you to import a variety of file formats, EPS 
files are recommended for all raster images you want to import; some applications 
have printing problems when using file formats such as TIFF and PICT.

NOTE: It may be necessary to perform a “custom install” of your MS Office application 
if you are unable to import EPS elements.

Chapter 3:
Office 
Applications
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Although there are no color management options within office applications, color 
conversions do occur when you import images or page elements that were not defined 
in RGB. To avoid such conversions with imported files, use the EPS file format for 
artwork that is to be imported into office applications.

All RGB images placed in a document are affected by RGB Source and Rendering 
Style settings.

Tip for advanced users

If you place multiple RGB images, mixed non-photographic and photographic, a 
single CRD may not be suitable for all the images. In this case, you may want the 
photographic images to bypass the CRD altogether. To accomplish this, save the image 
in CMYK mode with a pixel-editing application, such as Photoshop, and perform 
color correction. Save the image as a Photoshop EPS and import it into the document. 

Selecting options when printing
There are few differences among office applications with regard to Color Server 
printing. The instructions in this chapter apply to all office applications. Follow the 
instructions in the Color Guide to specify print options and color management 
settings. To specify these options, you must use a PostScript Level 2 (or later) printer 
driver, such as an Adobe PostScript Printer Driver.

Because office applications send RGB data to the Color Server, your choices of 
RGB Source and Rendering Style settings are important. Specify the appropriate 
CRD for the color effect you want (see the Color Guide).

Output profiles
All color data in the job is affected by the output profile on the Color Server. This 
profile may be the one designed for your device and shipped with the Color Server, or 
it may be a custom profile created at your site (see the Color Guide). If necessary, print 
the Test Page to see which profile is currently resident on the Color Server. 
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This chapter covers features of Adobe Photoshop versions 6.x and 5.x for Windows 
and Mac OS. The illustrations show only Mac OS dialog boxes, but the information 
and instructions apply equally to the Windows version of Photoshop.

Because Photoshop uses a sophisticated color management system, there are several 
setup steps you should take before you begin working. These steps include: 

• Calibrate your monitor

• Adjust Photoshop color settings

Creating a monitor profile
You can use the Adobe Gamma control panel to create and customize an ICC profile 
that describes the unique display characteristics of your monitor. This monitor profile 
enables Photoshop to compensate for the color behavior of the monitor when 
displaying images. As a result, colors previewed on the monitor will more closely 
match colors in your printed output.

NOTE: If a profile for your monitor is not available, use the Adobe Gamma control 
panel setup Assistant (Wizard on Windows) to customize an available profile that, at a 
minimum, has the same type of phosphors as your monitor.

TO CREATE A MONITOR PROFILE

1. Display the Adobe Gamma control panel by double-clicking its icon in either the 
Windows or Mac OS Control Panel.

2. Click Assistant (Wizard on Windows) if you have not yet selected your monitor profile 
or want to customize your current profile,.

Chapter 4:
Adobe 
Photoshop
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3. Follow the step-by-step instructions in the Assistant or Wizard to calibrate your 
monitor and create a monitor profile.

Specifying color settings
The following sections outline the recommended color settings for Photoshop 6.x 
and 5.x in a Color Server workflow. These color settings include:

Working Spaces—Default color spaces to use when working with RGB and CMYK 
documents. ICC color profiles describe the gamut and color characteristics of these 
working spaces.

Color Management Policies (Photoshop 6.x) or Profile Mismatch Handling 
(Photoshop 5.x)—Instructions that tell Photoshop what to do when it encounters 
color data from a color space other than the specified working space.
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Photoshop 6.x color settings
Photoshop 6.x uses a sophisticated color management system that handles document 
colors for a variety of color-managed workflows. By customizing color settings, you 
can specify the amount of color management you want to use while working in 
Photoshop 6.x. 

TO SPECIFY COLOR SETTINGS FOR PHOTOSHOP 6.X

1. Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.

2. Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
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3. Choose the desired working space profile for each color mode in the 
Working Spaces area.

Use the following guidelines for specifying working spaces:

• For RGB, choose the profile for the default RGB color space used by the 
Color Server. In most cases, this is EFIRGB. Consider sRGB if you usually 
view images on a generic PC monitor or rely on a Windows operating system 
to manage color on your monitor. If you choose sRGB as a working space, you 
must print with the ColorWise RGB Source option set to sRGB.

New RGB documents you create in Photoshop will use this working space.

NOTE:EFIRGB is set as the default RGB Source color space on the Color Server. 
No matter what RGB space you select, make sure it is available on the Color Server. 
For more information on downloading RGB Source profiles to the Color Server, 
see the Color Guide.

•For CMYK, choose a profile that describes your target press (such as SWOP) if you 
are a prepress user. If you are an office user printing final output, choose an output 
profile that describes the device connected to the Color Server. To use a device-
specific output profile, you must first upload the profile from the Color Server to 
your computer (see the Color Guide). New CMYK documents you create in 
Photoshop will use the specified working space.

• For guidelines on specifying Gray and Spot working spaces, see your Photoshop 6.x 
documentation.

4. In the Color Management Policies area, choose policies for handling documents 
without embedded profiles or with embedded profiles that differ from the working 
space .

Unless you are an advanced color user, we recommend that you choose Off from the 
RGB, CMYK, and Gray menus. This option discards the original profile embedded in 
a document if it differs from the specified working space, while preserving the numeric 
color values in the document.

For Profile Mismatches, select Ask When Opening. This option displays an alert 
message that lest you override the specified policy behavior (Off ) when opening 
documents or importing color data.

5. In the Conversion Options area, specify settings for converting between color spaces.
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Choose Adobe (ACE) from the Engine menu to use the built-in color management 
engine for Photoshop.

Choose a rendering intent from the Intent menu that will optimize the color quality of 
the conversion. For guidelines on choosing the rendering intent, see your Photoshop 
6.x documentation. 

Select Use Black Point Compensation and Use Dither (8-bit/channel images) to 
optimize the quality of color conversions.

6. Clear the Desaturate Monitor Colors By and Blend RGB Colors Using Gamma options in 
the Advanced Controls area.

Deslecting these options helps optimize the matching of the monitor display to 
printed output.

7. Click Save to save the current group of color settings.

The Save dialog box appears. 

8. Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Color Settings dialog box.

Photoshop 5.x color settings
Like Photoshop 6.x, Photoshop 5.x offers settings for default RGB and CMYK color 
spaces and color management policies.

Photoshop 5.x allows you to use two simultaneous RGB spaces, one for the monitor 
and one for the Photoshop RGB working space. The monitor RGB space setting does 
not affect the image data in the file; it affects only the way the image is displayed on the 
monitor. Even if an RGB image has been prepared with different monitor settings, it 
is still correctly displayed on your monitor, without changes to the original values in 
the file.
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TO SET PROFILE DEFAULTS IN PHOTOSHOP 5.X

1. Choose Color Settings>Profile Setup from the Photoshop 5.x File menu.

2. In the Embed Profiles area, specify whether to embed the appropriate ICC profiles 
when saving a file. 

Unless you are an advanced color user, we recommend that you clear the profile 
embedding options for RGB and CMYK files.

By embedding a profile during the saving process, Photoshop links a color space 
(working space) definition with that file for future use. When you open an image that 
already contains a profile, Photoshop alerts you as to which color space the file was 
saved in. Avoid conversions between color spaces as much as possible, as each 
conversion results in loss of color information.

3. Choose Ask When Opening from the RGB and CMYK menus in the Assumed 
Profiles area. 

When you open files that do not contain an ICC profile, you can convert the file to 
your current Photoshop working space setting or leave the file unconverted—the 
preferred choice—but make sure the current Photoshop working space setting matches 
the intended color space of the image.

4. Choose Ask When Opening from the RGB and CMYK menus in the Profile Mismatch 
Handling area.
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When you open a file that contains an ICC profile that does not match your current 
Photoshop working space setting, you have the choice to convert from the embedded 
profile or not. If you want to preserve the color integrity of the source image, do not 
convert. When you open the image, immediately go to RGB or CMYK Setup to 
specify the working space for the image. If your working space is set to your output 
device, you may want to convert.

TO SET RGB DEFAULTS

1. Choose Color Settings >RGB Setup from the Photoshop 5.x File menu.

2. Choose your current Photoshop RGB color space from the RGB menu. 

Your selection should reflect the color space of most RGB files you will be opening. 
If you create new RGB files or want to standardize your RGB files, choose EFIRGB. 

3. Click Load if the file is not visible in the RGB menu. 

You can load the Calibrated RGB setup file, EFIRGB ICC ColorSync file, or 
EFIRGB.ICM file. All describe the same RGB space and automatically set the 
Gamma, White Point, and Primaries. Consider sRGB if you usually view images on a 
generic PC monitor or rely on a Windows operating system to manage color on your 
monitor. If you choose sRGB as a working space, print with the ColorWise RGB 
Source option set to sRGB.

NOTE: EFIRGB is set as the default RGB Source color space on the Color Server. 
No matter what RGB space you select, make sure it is available on the Color Server. 
For more information on downloading RGB Source profiles to the Color Server, 
see the Color Guide.

Select this option
Select this option
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The Monitor area shows the currently selected profile in the Adobe Gamma control 
panel. Select both the Display Using Monitor Compensation and Preview options.

TO SET CMYK DEFAULTS

1. Choose Color Settings > CMYK Setup from the Photoshop 5.x File menu.

2. Select the Preview option. 

For CMYK Model, select ICC. Previous versions of Photoshop used Photoshop 
Separation Tables, and you can load them for Photoshop 5.x. However, you will get 
better results using ICC profiles and the built-in color management system.

3. Choose settings from the Profile, Engine, and Intent menus in the ICC Options area. 

• For Profile, choose your final output device ICC profile. Prepress users should 
choose an ICC describing their target press, such as SWOP. Office users should 
choose the ICC profile describing the device connected to the Color Server. In this 
case, we recommend that you leave images in RGB and allow the Color Server to 
convert them to CMYK. However, if you want to use Photoshop to convert RGB 
images to the CMYK color space of the Color Server, you must first upload one of 
the output profiles from the Color Server to your computer (see the Color Guide), 
and then select it in Photoshop CMYK Setup. The output profile for the 
Color Server is also available on the User Software CD (see the User Software 
Installation Guide).

NOTE:With the RGB Separation feature of the Color Server, you can preview (print) 
your conversions from RGB to any simulated CMYK space by downloading the 
desired target profile to the Color Server. For more information about downloading 
profiles, see the Color Guide.

Select this option



44-9 Saving files
• For Engine, choose Built-in so that the Photoshop engine will be used.

• For Intent, choose Perceptual (Images), which is appropriate for photographs 
normally edited in Photoshop. The Intent setting is used only when you convert 
between color spaces.

At times it may be useful to select the Black Point Compensation option. With many 
ICC profiles, this option has no effect. When it does, it has a dramatic effect on the 
dark areas of your image. If you want this effect, select Black Point Compensation; if 
not, clear the option.

Saving files
Before saving a file from Photoshop, perform any necessary rotating, cropping, and 
resizing. This speeds processing when printing from the application in which the image 
is placed.

We recommend you use EPS or TIFF file formats to save RGB images that will be 
imported into other documents and printed to the Color Server. You can import EPS 
and TIFF files into virtually all page layout applications.

NOTE: Although TIFF files display better when imported into other applications, their 
color and resolution characteristics may be altered by the application into which they 
are imported. EPS files are unaffected.

Saving files from Photoshop 6.x or 5.x
The process of saving documents from Photoshop 5.x is virtually identical to that of 
saving documents from Photoshop 6.x. In the following procedure, only Photoshop 
6.x (Mac OS version) dialog boxes are shown. When applicable, differences between 
the 6.x and 5.x, and the Windows and Mac OS versions of Photoshop are noted.

When saving a document from Photoshop 6.x, you have the option to embed a color 
profile in the document. We recommend you disable this option if you are sending the 
document to the Color Server.



44-10 Adobe Photoshop
TO SAVE A DOCUMENT FROM PHOTOSHOP 6.X OR 5.X

1. Choose Save As from the File menu.

The Save As dialog box appears.

2. Specify settings in the Save As dialog box.

• Specify a name, file format, and saved location for the document.

• Clear the Embed Color Profile option (Mac OS) or ICC Profile option (Windows).
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3. Click Save.

If you chose Photoshop EPS as the format, the EPS Options dialog box appears.

4. Specify EPS options and click OK.

• Choose a TIFF preview option. A TIFF preview is compatible with both Windows 
and Mac OS computers.

• Do not select the PostScript Color Management option. For more information 
about PostScript Color Management, see the following section. 

• Do not select Include Transfer Function or Include Halftone Screen.

NOTE: If you choose JPEG encoding, save a backup of the original image saved with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see 
unexpected results in the printed output of a JPEG file, revert to a binary version.

If you experience problems printing the document in which you placed the image, 
substitute an ASCII version of the same image and reprint the document. Binary 
encoding is much more compact than ASCII encoding, but occasionally causes 
printing problems with some system configurations.
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Advanced tips for using PostScript color management
Use the following information to implement alternative, more complex, color 
workflows with Photoshop.

Saving EPS documents with PostScript Color Management

Selecting the PostScript Color Management option when saving either a CMYK or 
RGB EPS file prompts Photoshop to embed PostScript color information—which is 
independent of ICC profiles—in the resulting document. This information is intended 
for PostScript devices like the Color Server.

Printing RGB EPS files saved with PostScript Color Management

When you print an RGB EPS file that contains an embedded profile to the 
Color Server, you can use the working space information from the embedded RGB 
profile as an RGB source definition for Color Server CRDs. To use this source color 
space information from the embedded profile with Color Server CRDs, choose None 
as the ColorWise RGB Source when you print. This applies when you print directly 
from Photoshop, or when the same RGB EPS file is output from another application.

To override the embedded profile in an EPS file using an RGB Source definition made 
available by the Color Server, choose anything except None as the Color Server RGB 
Source Profile.

Printing CMYK EPS files saved with PostScript Color Management

If you select the Photoshop PostScript Color Management option when you save a 
CMYK EPS image, Photoshop embeds PostScript color information that defines the 
CMYK source color space of the image. When you print a CMYK EPS file that 
contains PostScript color information to the Color Server, CRDs are used instead of 
ColorWise CMYK Simulation and Simulation Method settings. Choose the 
appropriate setting for the Rendering Style option.
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Defining colors
You can choose colors in Photoshop with various color models, including HSB, CIE 
Lab, RGB, and CMYK. You can also choose named colors from the PANTONE 
Coated color library. For best results, use the color definition methods described 
in Chapter 2.

Selecting options when printing
You can print RGB or CMYK images from Photoshop 6.x and 5.x. 

• When you print an RGB image, you choose whether the conversion to CMYK is 
performed by the Color Server (using a CRD), PostScript (using PostScript Color 
Management), or Photoshop built-in color management.

• When you print a CMYK image, you can print composites or color separations.

NOTE: You cannot use the Combine Separations feature of the Color Server to 
recombine separations printed from Photoshop.

TO PRINT IMAGES FROM PHOTOSHOP 6.X OR 5.X

1. Choose Print from the File menu.

The Print dialog box appears.

Photoshop 6.x
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2. Choose the Color Server destination from the Printer menu, and then choose Adobe 
Photoshop.

3. Choose an Encoding method. 

NOTE: If you choose JPEG encoding, save a backup of the original image with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see 
unexpected results in the printed output of a JPEG file, revert to the binary version.

4. Specify the color space for printing the image. 

• For Photoshop 6.x, choose Same as Source from the Profile menu.

• For Photoshop 5.x, choose RGB Color from the Space menu if you are printing an 
RGB image. Choose CMYK Color if you are printing a CMYK image.

Any other setting causes Photoshop to convert image data to that color space before 
sending it to the Color Server.

5. For Photoshop 5.x, make sure PostScript Color Management is cleared.

6. Click Print.

Photoshop 5.x
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Advanced tips for printing with Photoshop PostScript 
color management
Use the following information to implement alternative, more complex, color 
workflows with Photoshop.

• To use PostScript color management with Photoshop 6.x, choose PostScript Color 
Management from the Profile menu in the Photoshop pane of the printer driver.

• To use PostScript color management with Photoshop 5.x, select the PostScript Color 
Management option in the Photoshop pane of the printer driver.

Printing RGB images with Photoshop PostScript Color Management 

If you select an RGB color space and decide to use PostScript Color Management, 
Photoshop sends RGB data to the Color Server along with PostScript color 
information defining this RGB color space. Note that when you select PostScript 
Color Management, a CRD will be used to perform color conversions to CMYK.

NOTE: The included RGB source color space information is overridden by the 
ColorWise RGB Source option unless it is set to None. The ColorWise Rendering 
Style option specified will take effect if the ColorWise RGB Source Profile option is set 
to None.

For fastest print times, you can choose JPEG encoding, but check printed output 
carefully for unwanted artifacts that can appear as a result of JPEG compression. If you 
see unexpected results in the printed output, print the job again using Binary or 
ASCII encoding.

Printing CMYK images with Photoshop PostScript Color Management

If you select a CMYK color space and decide to use PostScript Color Management, 
Photoshop sends CMYK data to the Color Server along with PostScript color 
information defining this CMYK color space. Note that when you select PostScript 
Color Management, a CRD will be used to perform color conversions to the CMYK 
color space of the Color Server.
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The destination color space for the CRDs is determined by the RGB Separation print 
option. If RGB Separation is set to Simulation, the CMYK image is printed according 
to all specified CMYK Simulation Profile and CMYK Simulation Method settings. 
If RGB Separation is set to Output, the CMYK image is converted to the CMYK color 
space of the selected output profile.

The Spot Color Matching setting has no effect, because Photoshop converts spot 
colors to CMYK values when you work in CMYK mode.

• If the image was separated for an offset press standard, apply the corresponding 
CMYK Simulation setting. For example, if the image is separated for SWOP, choose 
SWOP as the CMYK Simulation setting. 

• If Photoshop is configured for a custom separation using a ICC profile, choose the 
corresponding profile for the ColorWise CMYK Simulation option. 

The previous custom simulation setting requires that the same profile used for 
separation in Photoshop also resides on the Color Server. For more information 
about downloading CMYK Simulation profiles to the Color Server with 
ColorWise Pro Tools, see the Color Guide.
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This chapter provides instructions for printing color documents from Adobe 
InDesign 1.5.2, Adobe PageMaker 7.x and 6.5, and QuarkXPress 4.02 and 3.32. 

Before printing from these applications, make sure the appropriate printer driver 
and the Color Server PPD are installed on your computer, as described in the User 
Software Installation Guide. 

Working with page layout applications
The following sections apply to all page layout applications.

Defining colors
Page layout applications generally use the CMYK color model. Some allow you 
to define colors with other color models and may be able to send that data to the 
Color Server in those other color models. Generally, however, CRDs (which affect 
only RGB data) do not affect colors defined in page layout applications. For 
predictable results with CMYK colors, use the CMYK Color Reference when defining 
colors in page layout applications (see “Choosing colors in PostScript applications” on 
page 2-6). 

NOTE: If the application allows you to define colors in RGB, determine whether it 
converts the RGB data to CMYK before sending it to the Color Server. If it does, this 
will determine which ColorWise print options affect your job. For example, if the 
application converts RGB black (defined in the document as R0%, G0%, B0%) to 
four-color CMYK black when it sends the job to the Color Server, the Pure Black 
Text/Graphics option will have no effect when you print the job. 

You can also choose named colors from the PANTONE color library (see “PANTONE 
Coated Color Reference” on page 2-7).

Chapter 5:
Page Layout 
Applications
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Importing images
EPS (or EPSF) and TIFF are the recommended formats for images imported into 
page layout documents. Support for importing other file formats may be provided by 
individual applications. 

All RGB images placed in a document are affected by the RGB Source and 
Rendering Style settings. The ColorWise color management system applies the 
specified RGB Source setting to all RGB data and then uses the specified Rendering 
Style (CRD) to perform a color conversion. An exception to this occurs if you assign 
ICC profiles to RGB images using the application’s color management tools. (See 
“Tips for advanced users” in the following section). In this case, the application 
performs the color conversion of the image and sends CMYK data to the Color Server.

NOTE: To take advantage of RGB Source and Rendering Style settings for images 
imported into QuarkXPress 4.02, save images in the EPS format or use the Quark 
PrintRGB XTension, which outputs RGB TIFF image files without converting them 
to CMYK.

Tips for advanced users

If you place multiple RGB images, some non-photographic and some photographic, 
a single CRD may not be suitable for all the images. In this case, you may want the 
photographic images to bypass the CRD altogether. To accomplish this, separate the 
image to CMYK data with a pixel-editing application, such as Photoshop, and perform 
color correction. Save the file as EPS or TIFF and import it into the document. 

If your application supports this feature, you can save the RGB image in TIFF format 
and assign it an ICC profile and rendering intent when you import it into the 
document.
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CMYK simulation
You can specify a CMYK Simulation profile and a CMYK simulation method for a job 
using the CMYK Simulation Profile and CMYK Simulation Method print options (see 
the Color Guide). The CMYK Simulation setting affects all CMYK color data sent by 
the page layout application. It can also affect RGB data if RGB Separation is set to 
Simulation.

• If the document contains CMYK images that were separated for an offset press 
standard, apply the corresponding CMYK Simulation setting. For example, for 
images separated for SWOP, choose SWOP as the CMYK Simulation setting. 

If you print separations to the Color Server and choose to use the Combine 
Separations feature in conjunction with Full Simulation, the result may not match 
that of the same page printed as composite.

• If the document contains CMYK images that were separated according to the color 
characteristics of a custom ICC profile (not a press standard profile), specify the 
corresponding profile as the CMYK Simulation Profile setting on the Color Server. 

NOTE: To achieve the workflow described earlier, the profile used for the separation 
of CMYK images in the document should also reside on the Color Server. For more 
information on downloading CMYK Simulation profiles to the Color Server with 
ColorWise Pro Tools, see the Color Guide.

Adobe InDesign 1.5.2
The following sections outline the recommended settings for using Adobe InDesign 
1.5.2 in a Color Server workflow.

InDesign color settings
When using ColorWise color management, turn off the InDesign color management 
features.
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TO DISABLE INDESIGN COLOR MANAGEMENT

1. Choose Color Settings > Document Color Settings from the Edit menu.

The Document Color Settings dialog box appears.

2. Clear the Enable Color Management option and click OK.

Importing images
All RGB images, except for RGB TIFF images, placed in a document are affected by 
your RGB Source and Rendering Style settings. For best results with placed images, use 
the instructions in “Importing images” on page 5-2 and “CMYK simulation” on 
page 5-3.

NOTE: InDesign 1.5.2 converts placed RGB TIFF images to CMYK.

Disable InDesign color management when placing images in a document.
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TO DISABLE INDESIGN COLOR MANAGEMENT WHEN IMPORTING IMAGES

1. Choose Place from the File menu.

The Place dialog box appears.

2. Select the Show Import Options option.

3. Select the file you want to import and click Place.

The Image Import Options dialog box appears.

4. Choose Color Settings from the option menu. Make sure the Enable Color Management 
option is cleared, and click OK.

Selecting options when printing
You can use the standard Color Server printer driver interface to select print options 
from InDesign 1.5.2.
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TO SET PRINT OPTIONS FROM THE WINDOWS VERSION OF 
INDESIGN 1.5.2

1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Color Server from the Name menu.

3. Click Properties.

4. Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Color Server appears.

5. Choose the desired print options.

For information on setting ColorWise print options, see the Color Guide.
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TO SET PRINT OPTIONS FROM THE MAC OS VERSION 
OF INDESIGN 1.5.2

1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Color Server from the Printer menu.

3. Choose Printer Specifc Options from the options menu.

The Color Server print options appear.

4. Select the desired options.

For information on setting ColorWise print options, see the Color Guide.

Adobe PageMaker 7.x and 6.5 for Mac OS and Windows
The Mac OS and Windows versions of PageMaker 7.x and 6.5 are essentially the same. 
The illustrations in this section show only the Windows version, except where 
differences exist between the two versions.

PageMaker color settings
We recommend you use ColorWise color management rather than the CMS options 
built into Adobe PageMaker. 

NOTE: Do not use both systems for the same print job. 
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TO DISABLE PAGEMAKER COLOR MANAGEMENT 

1. Choose Preferences > General from the File menu.

2. Click CMS Setup.

3. Choose Off from the Color Management menu.

4. Click OK, and then click OK again to close the dialog boxes. 

TO DISABLE COLOR MANAGEMENT FOR A BITMAPPED IMAGE

1. Select the bitmapped image in the document.

2. Choose Image > CMS Source from the Element menu.

3. Choose None from the This Item Uses menu and click OK.

Windows version requirement
For the Windows version of PageMaker 6.5, make sure a copy of the Color Server PPD 
file is in the following folders:

• PM65\RSRC\USENGLSH\PPD4

• Windows\System

Importing images
All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings. For best results with placed images, use the instructions in “Importing 
images” on page 5-2 and “CMYK simulation” on page 5-3.
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Selecting options when printing
All print settings are specified from the various Print dialog boxes in PageMaker 7.x 
or 6.5. The printer driver interface described in the Color Guide is not used.

TO SET PRINT OPTIONS WHEN PRINTING FROM PAGEMAKER

1. Choose the Color Server PPD from the PPD menu in the Print Document dialog box.

2. Click Options.

3. Choose Normal from the “Send image data” menu in the Print Options dialog box and 
click Features.

To ensure that TIFF images print at their full resolution, do not choose the Optimized 
Subsampling default from the “Send image data” menu.

Choose the Color Server PPD

Click Options
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4. If a document contains RGB placed images or colors defined in RGB that will not be 
separated to process colors, choose RGB Source and Rendering Style settings in the 
Print Features dialog box.

If the document contains PANTONE colors, choose the appropriate Spot Color 
Matching setting. 

5. Click Print from any of the PageMaker dialog boxes to send the job to the Color Server. 

NOTE: The printer driver dialog boxes described in the Color Guide do not appear.

Optional Color Management from PageMaker
If you have additional color management requirements not offered by ColorWise, 
such as managing color on devices not controlled by the Color Server, consider using 
the PageMaker color management features. For more information, see your PageMaker 
documentation.

QuarkXPress 4.x for Mac OS and Windows
If you have additional color management requirements not offered by ColorWise, 
consider using Quark CMS XTension for QuarkXPress 4.02. These features allow 
advanced users to control RGB to CMYK color conversions. If you plan to use these 
features, make sure the Quark CMS XTension is installed before starting QuarkXPress. 
If it is not installed, use the Quark XTensions Manager to install it. For instructions, 
see your QuarkXPress documentation.
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NOTE: Quark CMS converts RGB TIFF, JPEG, and PICT images to CMYK before 
sending color data to the Color Server. RGB Source and Rendering Style settings have 
no effect on this data unless you use Quark PrintRGB XTension, which outputs RGB 
TIFF image files without converting them to CMYK.

Importing images
With the exception of RGB images that are saved in EPS format or use Quark 
PrintRGB XTension, QuarkXPress 4.02 converts all RGB data into CMYK, even 
when Quark CMS XTension is disabled.

Only RGB images saved in EPS format are affected by RGB Source and Rendering 
Style settings. For best results with placed images, follow the instructions in 
“Importing images” on page 5-2 and “CMYK simulation” on page 5-3.

Selecting options when printing
The following procedure provides instructions on printing files to the Color Server.

TO SET PRINT OPTIONS IN QUARKXPRESS 4.X

1. Choose the Color Server PPD from the Printer Description menu in the Print dialog box.

Choose the Color Server PPD

Mac OS

Choose an output paper size

Click to specify printer settings
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2. If the document contains PANTONE colors, choose the appropriate Spot Color 
Matching setting. 

For instructions on specifying print options, see the Color Guide.

Optional Color Management from QuarkXPress
If you have additional color management requirements not offered by ColorWise, 
such as managing color on devices not controlled by the Color Server, you may want 
to consider using the QuarkXPress color management features. For more information, 
see your QuarkXPress documentation.

QuarkXPress 3.32 for Mac OS and Windows
Before starting QuarkXPress 3.32, make sure the EfiColor XTension is not loaded in 
the XTensions folder. EFICOLOR profiles are not currently provided with 
Color Server products. Without the correct EFICOLOR profile, the EfiColor 
XTension cannot perform color conversions on placed images.

Choose the Color Server 
device

Windows

Click to specify
device settings

Choose the Color Server PPD
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Windows version requirement
For the Windows version of QuarkXPress, make sure a copy of the Color Server PPD 
file is in the \XPRESS\PDF folder. 

Importing images
All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings. For best results with placed images, follow the instructions in 
“Importing images” on page 5-2 and “CMYK simulation” on page 5-3. 

Selecting options when printing
The following procedure provides instructions on printing files to the Color Server.

TO SELECT PRINT OPTIONS IN QUARKXPRESS 3.3

1. Choose the Color Server PPD from the Printer Type menu in the Page Setup (Mac OS) or 
Printer Setup (Windows) dialog box.

Choose an output paper size 

Choose the Color Server PPD

Mac OS

Choose Binary
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2. If a document contains RGB-placed images or RGB colors that QuarkXPress will print 
without converting to CMYK, choose RGB Source and Rendering Style settings. 

If the document contains PANTONE colors, choose the appropriate Spot Color Matching 
setting. 

For instructions on specifying print options, see the Color Guide.

Choose the Color Server PPD

Windows

Choose output
paper size

Choose Binary
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This chapter provides instructions for using Adobe Illustrator, Macromedia FreeHand, 
and CorelDRAW for Windows and Mac OS. 

Before printing from these applications, make sure the appropriate PostScript printer 
driver and the Color Server PPD are installed on your computer, as described in the 
User Software Installation Guide. 

Working with illustration applications
You can print directly from an illustration application or use it to create and save files 
that will be imported into a page layout document. To print from an illustration 
application, use the printer driver and print settings recommended in the Color Guide. 

NOTE: This manual provides instructions for printing composites only. 
For instructions on printing color separations, see the documentation for your 
application.

As a general rule, use the EPS file format when saving files with an illustration 
application.

Defining colors
All illustration applications use the CMYK color model. Although you may be 
allowed to define colors using other color models, these applications generally send 
only CMYK data to the Color Server. (The one exception is Illustrator 9.x, which 
can send either CMYK or RGB data to the Color Server.) For predictable results 
with CMYK colors, use the CMYK Color Reference pages when defining colors 
(see “Choosing colors in PostScript applications” on page 2-6).

Chapter 6:
Illustration 
Applications
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NOTE: If you define colors in RGB and print directly from the application, the 
application converts the RGB data to CMYK before sending it to the Color Server. 
This conversion by the application will determine which ColorWise print options 
affect your job. For example, if the application converts RGB black (defined in your 
document as R0%, G0%, B0%) to four-color CMYK black when it sends the job to 
the Color Server, the Pure Black Text/Graphics option in the PPD will have no effect 
when you print the job. 

You can also choose named colors from the PANTONE color library (see page 2-7).

Importing images
In general, all images placed in illustration applications should be in EPS file format. 

All RGB images placed in a document are affected by the RGB Source and 
Rendering Style settings in the PPD. The ColorWise color management system 
applies the specified RGB Source setting to all RGB data and then uses the 
specified Rendering Style (CRD) to perform a color conversion to CMYK. 
An exception to this occurs if you assign ICC profiles to RGB images using the 
application’s color management tools (see “Tips for advanced users” in the 
following section). In this case, the application performs the color conversion 
of the image and sends CMYK data to the Color Server.

Tips for advanced users

If you place multiple RGB images, some non-photographic and some photographic, 
a single CRD may not be suitable for all the images. In this case, you may want the 
photographic images to bypass the CRD altogether. To accomplish this, separate 
the image to CMYK data with a pixel-editing application such as Photoshop, and 
perform color correction. Save the image as an EPS or TIFF file and import it into 
the document. You can also save the RGB image in TIFF format and assign it an 
ICC profile and rendering intent when you import it into the document (see the 
discussions of specific applications in this chapter).
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CMYK simulation
You can specify a press simulation target and a press simulation method for the job 
with print options (see the Color Guide). The CMYK Simulation setting affects all 
CMYK color data sent by the illustration application. 

• If the document contains CMYK images that were separated for an offset press 
standard, apply the corresponding CMYK Simulation setting. For example, for 
images separated for SWOP, choose SWOP-Coated as the CMYK Simulation 
setting. 

• If the document contains CMYK images that were separated according to the color 
characteristics of a custom ICC profile (not a press standard profile), select the 
corresponding profile from the CMYK Simulation Profile print option on the 
Color Server. 

NOTE: The workflow described earlier requires that the profile used for the separation 
of CMYK images in the document also resides on the Color Server. For more 
information on downloading CMYK Simulation profiles to the Color Server with 
ColorWise Pro Tools, see the Color Guide.

Adobe Illustrator for Windows and Mac OS
The following sections provide guidelines for working with versions 9.x and 8.x 
of Adobe Illustrator.

Illustrator 9.x color settings
Illustrator 9.x uses a sophisticated color management system that can handle both 
RGB and CMYK colors for a variety of color-managed workflows. By customizing 
color settings, you can specify the amount of color management you want to use while 
working in Illustrator 9.x. These color settings include:

Working spaces—Default color spaces to use when working with RGB and CMYK 
documents. ICC color profiles describe the gamut and color characteristics of these 
working spaces.

Color management policies—Instructions that tell Illustrator 9.x what to do when it 
encounters color data from a color space other than the specified working space.
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Specifying print options
The following procedure outlines the recommended color settings for Illustrator 9.x 
in a Color Server workflow.

TO SPECIFY COLOR SETTINGS

1. Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.

2. Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
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3. Choose the desired working space profile for each mode in the Working Spaces area.

Use the following guidelines for specifying working spaces:

• For RGB, choose EFIRGB. This profile represents the default RGB color space used 
by the Color Server. New RGB documents you create in Illustrator will use this 
working space.

• For CMYK, choose a profile that describes your target press (such as SWOP) if you 
are a prepress user. If you are an office user printing final output, choose an output 
profile that describes the device connected to the Color Server. To use a device-
specific output profile, upload the profile from the Color Server to your computer 
(see the Color Guide). New CMYK documents you create in Illustrator will use the 
specified working space.

4. Choose policies for handling documents without embedded profiles or with embedded 
profiles that differ from the working space in the Color Management Policies area.

Choose Off from the RGB and CMYK menus. This option discards the original 
profile embedded in a document if it differs from the specified working space.

In the Profile Mismatches area, select the Ask When Opening option. This option 
displays an alert message that allows you to override the specified policy behavior (Off ) 
when opening documents or importing color data.

5. Choose settings for converting between color spaces in the Conversion Options area.

Choose Adobe (ACE) from the Engine menu to use the built-in color management 
engine for Illustrator.

Choose a rendering intent from the Intent menu that will optimize the color quality of 
the conversion. For guidelines on choosing the rendering intent, see your 
Illustrator 9.x documentation. 

Select the Use Black Point Compensation option to optimize the quality of 
color conversions.

6. Click Save to save the current group of color settings.

The Save dialog box appears. 

7. Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Color Settings dialog box.
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Illustrator 8.x color settings
If you are using ColorWise color management, disable the Illustrator 8.x color 
management system by removing the Color Conversion and Color Conversion 
Utilities files from the Adobe Illustrator >Plug-ins>Extensions folder.

Consider the following points when working in Illustrator 8.x:

• Any colors defined in Illustrator are sent to the printer in CMYK—even those 
defined using other color models. For best results, use the color definition 
methods described on page 2-6.

• All RGB images placed in a document are affected by the RGB Source and 
Rendering Style settings you select in the PPD. For best results with placed 
images, use the instructions in “Importing images” on page 6-2 and “CMYK 
simulation” on page 6-3.

If you have additional color management requirements not offered by ColorWise, 
such as managing color on devices not controlled by the Color Server, you may want 
to consider using the Illustrator color management features. For more information, 
see your Illustrator documentation.
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Specifying print options
The following procedure explains how to set print options when printing a document 
from Illustrator 9.x or 8.x to the Color Server.

TO SET PRINT OPTIONS IN ILLUSTRATOR

1. Choose Print from the File menu in Illustrator.

The Print dialog box appears.

2. For the Windows version of Illustrator, specify appropriate print options.

• Choose the Color Server device from the Name menu.

• Choose Composite from the Output menu.

• Choose Level 2 or 3 from the PostScript menu.

Windows

Choose Composite

Choose PostScript Level 2 or 3

Click Properties
to set print options

Select the device name
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3. For the Mac OS version of Illustrator, specify appropriate print options.

• Choose the Color Server device from the Printer menu.

• Choose Adobe Illustrator from the option menu below the Printer menu.

• Choose Composite from the Output menu.

• Choose Level 3 from the PostScript menu. 

4. If necessary, click Properties (Windows) or choose Printer Specific Options from the 
option menu (Mac OS) and choose RGB Source and Rendering Style settings for the 
Color Server. 

You only need to specify these settings if you have a CMYK document containing 
placed RGB images, or an RGB document in Illustrator 9.x. In all other cases, colors 
remain unaffected by the settings. 

5. If the document contains PANTONE-named colors, choose the appropriate Spot Color 
Matching setting. 

For instructions on setting additional ColorWise print options, see the Color Guide.

Saving files for importing into other documents
When saving files in Illustrator 9.x or 8.x for importing into other types of documents, 
use the EPS file format. Illustrator can save color information in both RGB and 
CMYK. The ColorWise RGB Source and Rendering Style settings affect color output 

Choose Composite

Choose PostScript
Level 3

Mac OS



66-9 FreeHand 9.x and 8.x for Windows and Mac OS
of RGB artwork saved in Illustrator EPS and imported into other kinds of documents 
(even when both RGB and CMYK artwork exists in the same file). In the case of 
Illustrator files imported into Photoshop, however, vector data from the Illustrator file 
is rasterized into bitmaps in Photoshop, and the final color space of the bitmap data is 
determined by the color mode you set in Photoshop.

FreeHand 9.x and 8.x for Windows and Mac OS
The information in this section applies to both the Windows and Mac OS versions 
of FreeHand 9.x and 8.x. Only Mac OS dialog boxes are shown, but the information 
and instructions are identical for the Windows version.

FreeHand color settings
When using ColorWise color management, turn off FreeHand color 
management features.

TO DISABLE COLOR MANAGEMENT IN FREEHAND 9.X OR 8.X

1. Choose Preferences from the File menu.

2. Click the Colors category in the Preferences dialog box.

3. Choose None for the type of color management.

Click Colors to access the color 
management settings
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Defining colors
Any colors defined in FreeHand are sent to the device in CMYK—even those defined 
using other color models. For best results, use the color definition methods described 
on page 2-6.

You can control the conversion of RGB colors defined in FreeHand by specifying 
settings in the Preferences dialog box under the Colors category, or choosing Color 
Management from the FreeHand menu on the Print dialog box.

Importing images
A number of file types can be imported into FreeHand, but once imported, all are 
treated as EPS images, TIFF images, or editable paths. For details, see your FreeHand 
documentation.

When you import an EPS image into a document, FreeHand inserts a link to the 
image rather than embedding the original file, resulting in a smaller file size. If the 
image is a CMYK EPS file, the colors print just as they would from the originating 
application. 

NOTE: Before placing a CMYK EPS file, be sure the file was saved with Desktop Color 
Separation (DCS) set to Off. If the file was saved with DCS activated, FreeHand prints 
composites of the image at the low resolution used for screen viewing.

All RGB images placed in a document are affected by your RGB Source and Rendering 
Style settings in the PPD. For best results with placed images, follow the instructions 
in “Importing images” on page 6-2 and “CMYK simulation” on page 6-3.
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TO SET OPTIONS WHEN PRINTING FROM FREEHAND

1. Select the Use PPD option in the Print dialog box.

2. Choose Normal from the Print setting menu. 

• If the Use PPD option is selected, a plus sign (+) appears in front of the 
word “Normal.”

• If the PPD name for your Color Server is not displayed, click the button 
labeled “…” and choose the appropriate PPD from the menu that appears. 

3. To use ColorWise color management features, choose Output Options from the 
File menu.

The Output Options dialog box appears.

Click to select a PPD
(PPD name appears at right)

Choose Normal
Click to access

FreeHand Print Setup

Clear option to use ColorWise 
color management
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4. Make sure the “Convert RGB to process” option is cleared. 

If this option is selected, FreeHand color management settings are used to convert 
RGB colors and RGB TIFF, PICT, and JPEG images to CMYK.

5. If a document contains placed RGB images, choose RGB Source and Rendering Style 
settings in the PPD. 

With the exception of placed RGB images, these settings have no effect on colors 
printed with FreeHand. If the document contains PANTONE-named colors, choose 
the appropriate Spot Color Matching setting in the PPD. 

For information about other FreeHand print options, see your FreeHand 
documentation.

Saving files for importing into other documents
When saving files in FreeHand 8.x for importing into other types of documents, use 
the EPS file format. FreeHand saves all color information in CMYK. The RGB Source 
and Rendering Style print options have no effect on the color output of RGB artwork 
saved in FreeHand 8.x and imported into other types of documents. In the case of 
FreeHand files imported into Photoshop, however, vector data from the FreeHand file 
is rasterized into bitmaps in Photoshop, and the final color space of the bitmap data is 
determined by the color mode you set in Photoshop.

Optional color management in FreeHand
If you have additional color management requirements not offered by ColorWise, such 
as managing color on devices not controlled by the Color Server, you may want to 
consider using the FreeHand color management features. For more information, see 
your FreeHand documentation.
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CorelDRAW for Windows and Mac OS
The following sections describe the recommended color settings for CorelDRAW 9.x 
and 8.x.

Defining colors
Any colors defined in CorelDRAW 9.x for Windows or CorelDRAW 8.x for Mac OS 
are sent to the device in CMYK—even those defined using other color models. For 
best results, use the color definition methods described in “Choosing colors in 
PostScript applications” on page 2-6.

You can control the conversion of RGB colors defined in CorelDRAW by specifying 
settings in the Color Management dialog boxes. On Windows computers, the Color 
Management dialog boxes are located in Tools > Color Management. On Mac OS 
computers, the Color Management functions are located in Edit:Preferences:Global.

NOTE: If you do not want to use color management in CorelDRAW, choose None from 
the Composite Printer menu under Color Management/Profiles. Do not select options 
under Color Management and Color Management General.

Importing images
All RGB images placed in a document are affected by the RGB Source and Rendering 
Style settings in the PPD. For best results with placed images, follow the instructions 
in “Importing images” on page 6-2 and “CMYK simulation” on page 6-3.
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Specifying print options
The following procedure outlines how to set print options when printing from 
CorelDRAW 9.x or 8.x to the Color Server.

TO SET PRINT OPTIONS IN CORELDRAW

1. On Windows computers, click the General tab, and then click Print.

2. Make sure you have selected the correct device and PPD, and select the 
Use PPD option. 

3. Click Properties to specify ColorWise print options.

Click Properties to access
ColorWise print options

Print device name appears here

Printer driver/PPD name 
appears here
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4. On Mac OS computers, click Printer in the General Print dialog box to select the device 
and print options.

To use ColorWise color management, make sure the “Use color profile” option on the 
Misc tab of the Print dialog box is cleared. If this option is selected, CorelDRAW color 
management settings are used to convert RGB colors and images to CMYK.

5. If a document contains placed RGB images, choose RGB Source and Rendering Style 
settings for your device.

With the exception of placed RGB images, these settings have no effect on colors 
printed with CorelDRAW. 

6. If the document contains PANTONE-named colors, choose the appropriate Spot Color 
Matching setting.

Clear this option to use 
ColorWise Color Management
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Saving files for importing into other documents
When saving files in CorelDRAW for importing into other types of documents, 
use the EPS file format. CorelDRAW saves all color information in CMYK, so RGB 
Source and Rendering Style print options have no effect on color output of artwork 
saved with CorelDRAW and imported into other kinds of documents. In the case 
of CorelDRAW files imported into Photoshop, however, vector data from the 
CorelDRAW file is rasterized into bitmaps in Photoshop, and the final color space 
of the bitmap data is determined by the color mode you set in Photoshop.

Optional color management in CorelDRAW
If you have additional color management requirements not offered by ColorWise, 
such as managing color on devices not controlled by the Color Server, consider using 
the CorelDRAW color management features. For more information, see your 
CorelDRAW documentation.
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This appendix covers concepts that are basic to printing in color, including:

• Properties of color

• Printing techniques

• Effective use of color

• Raster images and vector images

• File optimization for processing and printing

If you are already familiar with color theory and digital color printing, you can skip to 
the last section (“Optimizing files for processing and printing” on page A-16) for tips 
on optimizing files for printing.

The properties of color
This section introduces concepts that are basic to color theory. You will encounter 
some of these concepts (such as hue, saturation, and brightness) when you work with 
color in applications; others provide useful background information. Color is a complex 
topic, so consider this a starting point for experimentation and further research.

The physics of color
The human eye can see electromagnetic radiation at wavelengths between 
400 nanometers (purplish blue) and 700 nanometers (red). This range is called the 
visible spectrum of light. We see pure spectral light as intensely saturated or pure 
colors. Sunlight at midday, which we perceive as white or neutral light, is composed 
of light from across the visible spectrum in more or less equal proportions. 

Appendix A: 
Desktop 
Color Primer
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Shining sunlight through a prism separates it into its spectral components, resulting in 
the familiar rainbow of colors shown in the following figure.

Like the sun, most light sources we encounter in our daily environment emit a mixture 
of light wavelengths, although the particular distribution of wavelengths can vary 
considerably. Light from a tungsten light bulb, for example, contains much less blue 
light than sunlight. Tungsten light appears white to the human eye, which, up to a 
point, can adjust to the different light sources. However, color objects appear different 
under tungsten light than they do in sunlight because of the different spectral makeup 
of the two light sources.

The mixture of light wavelengths emitted by a light source is reflected selectively by 
different objects. Different mixtures of reflected light appear as different colors. Some 
of these mixtures appear as relatively saturated colors, but most appear as grays or 
impure hues of a color.



AA-3 Desktop Color Primer
CIE color model
In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a 
standard color space, a way of defining colors in mathematical terms, to help in 
the communication of color information. This color space is based on research on 
the nature of color perception. The following CIE chromaticity diagram is a 
two-dimensional model of color vision. The arc around the top of the horseshoe 
encompasses the pure, or spectral, colors from blue-violet to red. Although the CIE 
chromaticity diagram is not perceptually uniform—some areas of the diagram seem 
to compress color differences relative to others—it is a good tool for illustrating some 
interesting aspects of color vision.

By mixing any two spectral colors in different proportions, we can create all the colors 
found on the straight line drawn between them in the diagram. It is possible to create 
the same gray by mixing blue-green and red light or by mixing yellow-green and blue-
violet light. This is possible because of a phenomenon peculiar to color vision called 
metamerism. The eye does not distinguish individual wavelengths of light. Therefore, 
different combinations of spectral light can produce the same perceived color. 
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Purple colors, which do not exist in the spectrum of pure light, are found at the 
bottom of the diagram. Purples are mixtures of red and blue light—the opposite ends 
of the spectrum. 

Hue, saturation, and brightness
A color can be described in terms of three varying characteristics, called the HSB 
color model: 

• Hue—tint (the qualitative aspect of a color—red, green, or orange)

• Saturation—the purity of the color

• Brightness—relative position between white and black

While the CIE chromaticity diagram shown earlier conveys hue and saturation, 
a three-dimensional color model is required to add the brightness component, as 
shown in the following figure.

Brightness

Saturation
Hue
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Many computer applications include dialog boxes in which you choose colors by 
manipulating hue, saturation, and brightness. For example, some applications use a 
color picker that can be reconfigured according to your preference (as shown in the 
following figure).

Additive and subtractive color systems
Color devices used in desktop publishing and printing simulate the range of visible 
colors using a set of primary colors that are combined to create other colors. There are 
two methods for creating a range of colors from a set of primary colors. Computer 
monitors and scanners are based on the additive color model. Printing technologies, 
including the Color Server and offset presses, are based on the subtractive color 
model.

Additive (RGB) color

Color devices that use the additive color model create a range of colors by combining 
varying amounts of red, green, and blue light. These colors are called the additive 
primaries (shown in the following figure). White is created by adding the maximum 
amount of red, green, and blue light available. Black occurs wherever all three colors 
are absent. Grays are created by adding equal amounts of all three color together. 
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Combining varying amounts of any two of the additive primaries creates a third, 
saturated hue.

A familiar device that is based on this color model is the computer monitor, shown in 
the following figure. Monitors have red, green, and blue phosphors that emit varying 
amounts of light to display a given color. Scanners create digital representations of 
colors by measuring their red, green, and blue components through colored filters.
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Subtractive (CMY and CMYK) color

The subtractive color model is the basis for color printing, color photographic prints, 
and transparencies. While the additive color model simulates the visible spectrum of 
color by adding light of three primary hues, the subtractive color model starts with a 
“white” or neutral light source containing light of many wavelengths. Inks, toners, or 
other colorants are used to selectively absorb (subtract) certain wavelengths of light 
that otherwise would be reflected or transmitted by the media in use. 

The subtractive primaries are cyan, magenta, and yellow; they absorb red, green, and 
blue light, respectively (as shown in the following figure). Combining any two 
subtractive primaries creates a new color that is relatively pure or saturated. For 
example, you can make red by combining magenta and yellow, which absorb green and 
blue light, respectively. White occurs when no colorant is applied. In theory, 
combining all three subtractive primaries yields black, but due to deficiencies of cyan, 
magenta, and yellow colorants, combining these three primaries actually yields a 
muddy brown. Black colorant is added to compensate for the deficiencies of cyan, 
magenta, and yellow colorants. Consequently, color printing uses four process colors: 
Cyan, Magenta, Yellow, and blacK (CMYK). The use of black toner produces rich, 
solid blacks and allows for improved rendering of black text.
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The CMYK colorants used in offset printing and by your printer toner are to some 
degree transparent. When one layer of colorant is applied on top of another, you see 
the effect of both. To create a range of intermediary colors, a method is required for 
varying the amount of each colorant that is applied. A technique called halftoning is 
used in offset printing, while color printers typically use a proprietary system for 
applying ink or toner colors that is similar to halftoning. 

Printing techniques
Until recently, most color printing was done on printing presses using one of several 
printing techniques—offset lithography, flexography, or gravure, to name a few. All 
traditional printing techniques require lengthy preparation before a press run can take 
place. Short-run color printing, including Color Server printing, eliminates most of 
this preparation. By streamlining the process of color printing, the Color Server makes 
short print runs economically feasible.

In contemporary offset lithographic printing, digital files from desktop computers are 
output to an imagesetter, which creates film separations. The film is used to make a 
prepress proof, which is an accurate predictor of the final print job and allows you to 
make corrections before going to press. Once the proof is approved, the printer makes 
plates from the film and runs the print job on the press. 

With the Color Server, you simply print the file. The Color Server processes the 
PostScript information in the file and sends four bitmaps (one each for cyan, 
magenta, yellow, and black) to the printer. The ease of Color Server printing makes 
possible experimentation that would be too costly on a press, allowing unlimited fine-
tuning of color and design elements.

Halftone and continuous tone devices
Halftoning is used in offset printing to print each process color at a different intensity, 
allowing millions of different colors to be reproduced using only the four process 
colors. Depending on the required intensity of a given color, toner is placed on paper 
in dots of different size. The grid of dots used for each toner color is called a screen. 
Halftone screens are aligned to unique angles designed to eliminate interference 
patterns called moiré that can arise with halftoning. 
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Some color printers are commonly referred to as continuous tone (contone) devices. 
They do not use traditional halftone screen patterns and angles. Contone devices are 
capable of varying the intensity of individual dots. 

Even if your color printing is done exclusively on the Color Server, you will encounter 
concepts from offset printing if you use high-end graphics applications. For example, 
color controls in illustration applications, such as Illustrator, are geared toward 
specifying color for offset printing using process and spot colors. Many applications 
allow you to specify the screening used for each printing plate. 

Using color effectively
The ability to print in color can greatly increase the effectiveness of your message, 
whether you are printing a presentation or newsletter, or proofing an ad concept that 
will later be printed on a press. Some potential benefits of using color include:

• Conveying information rapidly by using color cues

• Making use of the emotive aspects of different colors

• Increasing impact and message retention 

Color can also be a source of distraction and discord if it is used poorly. This section 
outlines some tips and concepts to consider as you approach designing color materials.
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A few rules of thumb
Try some of the following strategies for creating successful color materials:

• Use color to aid comprehension, rather than applying colors indiscriminately. 
In presentations, graphs, and charts, use color to highlight patterns and 
emphasize differences. 

• In general, fewer colors work better than many colors.

• Use red as an accent color. Red is particularly effective when used in otherwise 
monochromatic materials.

• Consider the tastes of your target audience when choosing colors. 

• Keep a file of printed color pieces that appeal to you or strike you as effective. 
Refer to it for ideas when designing your own documents.

Color wheel
A color wheel like the one in the following figure is a helpful tool for understanding 
the interrelation of colors. The colors on one side of the color wheel, from magenta to 
yellow, appear to most people to be warm colors, while those on the other side, from 
green to blue, appear to be cool. The distance between two colors on the color wheel 
can help predict how they will appear when seen side by side.
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Colors opposite one another on the color wheel are called complements (see example a 
in the following figure), and create a striking contrast side by side. This can be the basis 
for a bold graphical design, but it is an effect you should use with discretion, since it 
can be visually fatiguing. Other bold combinations to consider are split 
complements—a color and the two colors adjacent to its complement (example b)—
and triads (three colors evenly spaced on the color wheel (example c). Colors adjacent 
to one another on the color wheel result in subtle harmonies.

The color wheel simplifies color relationships for the purpose of clarity, showing only 
saturated or pure colors. Adding the myriad variations of each hue to the palette (more 
or less saturated, darker, or lighter) creates a wealth of possibilities. Taking a pair of 
complements from the color wheel and varying the saturation and brightness of one or 
both colors produces a very different result from the pure complements. Combining a 
light tint of a warm color with a darker shade of its cooler complement often gives 
pleasing results. Combining a darker shade of a warm color with a light tint of its 
cooler complement produces an unusual effect that may appeal to you.

a cb
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Once you have mastered the concept of the color wheel, you have a good framework 
for experimenting with color combinations. Many books targeted at graphic designers 
show groups of preselected color combinations. Some are organized by themes or 
moods, and some are based on a custom color system, such as PANTONE. The more 
you develop a critical facility for judging color combinations, the more you will be able 
to trust your own eye for color. The bibliography at the back of this manual includes 
books on design.

Color and text
It is not a coincidence that the overwhelming majority of text you see is printed in 
black on white paper. Text in black on white is highly legible and is not fatiguing to 
read for extended periods. For many color materials, using black text on a white 
background and confining color to graphic elements and headings is a good choice.

Color text can add flair to documents printed on paper when used skillfully. This 
technique is widely used in presentations. When using color text, avoid dazzling text 
and background combinations created from primary complements, especially red and 
cyan or red and blue; they are visually fatiguing and hard to read. Color text is more 
legible when distinguished from its background by a difference in lightness—for 
example, dark blue text on a light beige background. In addition, using many different 
colors in a string of text makes for a confused appearance and is hard to read. However, 
using a single highlight color is an effective way to draw the reader’s eye to selected 
words. For color text samples, see the following figure.
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When using color text, keep in mind that small font sizes typically do not print in 
color with the same sharpness as in black. In most applications, black text prints 
exclusively in black toner, while color text usually prints with two or more toners. 
Any misregistration between the different toners on paper causes color text to lose 
definition. You can make test prints to find the smallest point size at which color text 
prints clearly. When using high-end graphics applications that allow you to specify 
color as percentages of cyan, magenta, yellow, and black, you can create pure cyan or 
pure magenta text that prints with the same sharpness as black text. (Pure yellow text is 
extremely hard to read on anything but a dark or complementary background.)

Raster images and vector images
Two broad categories of artwork can be printed from a personal computer to a color 
printer: raster and vector images.

A raster image, also referred to as a bitmap, is composed of a grid of pixels, each 
assigned a particular color value (as shown in example a in the following figure). The 
grid, when sufficiently enlarged, resembles a mosaic made from square tiles. Examples 
of raster images include scans and images created in painting or pixel-editing 
applications, such as Photoshop and Corel Painter.

STOP! STOP!

Exceptio probat
regulam de rebus
non exceptis.

De gustibus 
non est 
disputandum.
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The amount of data found in a raster image depends on its resolution and bit depth. 
The resolution of a raster describes the compactness of the pixels and is specified in 
pixels per inch (ppi). The bit depth is the number of bits of information assigned to 
each pixel. Black and white raster images require only one bit of information per pixel. 
Grayscale images require 8 bits per pixel. For photographic quality color, 24 bits of 
RGB color information are required per pixel, yielding 256 levels of red, green, and 
blue. For CMYK images, 32 bits per pixel are required.

When printing raster artwork, the quality of the output depends on the resolution of 
the source raster. If the raster resolution is too low, individual pixels become visible in 
the printed output as small squares. This effect is sometimes called “pixelation.”

In vector graphics, picture objects are defined mathematically as lines or curves 
between points—hence the term “vector” (see example b). Picture elements can have 
solid, gradient, or patterned color fills. Vector artwork is created in illustration and 
drawing applications, such as Illustrator and CorelDRAW. Page layout applications, 
such as QuarkXPress, also allow you to create simple vector artwork with their drawing 
tools. PostScript fonts are vector-based, as well.

Vector artwork is resolution-independent; it can be scaled to any size and resolution 
without danger of pixels becoming visible in printed output.

a b
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Optimizing files for processing and printing
The following sections provide tips on how to create image files that produce the 
highest possible print quality while minimizing the processing time and disk space they 
require.

Resolution of raster images
While a 72-ppi raster image appears sharp on a monitor, the same image would likely 
appear pixelated when printed to the Color Server. Color printers are capable of much 
greater detail than computer monitors, and require correspondingly higher resolution 
image files. However, high-resolution files can be large and, therefore, cumbersome to 
transmit over a network, process for printing, store on disk, and edit. 

Beyond a certain threshold, a higher image resolution greatly increases file size while 
having a minimal effect on output quality. The optimal image resolution depends on 
the resolution of the final print device. Aim for the resolution that optimizes both file 
size and output quality.

The resolution of a raster image, along with its bit depth and physical dimensions, 
determine its file size. The following table shows the file sizes of color raster images at 
different dimensions and resolutions.

File size at

Image size 100 ppi 150 ppi 200 ppi 400 ppi 600 ppi

RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK

3" x4" 0.4/0.5 MB 0.8/1.0 MB 1.4/1.8 MB 5.5/7.3 MB 12.4/16.5 MB

5" x 7" 1.0/1.3 MB 2.3/3.0 MB 4.0/5.3 MB 16.0/21.4 MB 36.1/48.1 MB

8.5" x 11" 2.7/3.6 MB 6.0/8.0 MB 10.7/14.3 MB 42.8/57.1 MB 96.4/128.5 MB

11" x 17" 5.4/7.1 MB 12.0/16.1 MB 21.4/28.5 MB 85.6/114.1 MB 192.7/256.9 MB
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In this table, the shaded areas indicate that 200 ppi is typically the best trade-off 
between image quality and file size. However, higher resolutions (for example, 
250 to 300 ppi) may be necessary for offset printing, when quality is of the utmost 
importance, or for images containing sharp diagonal lines.

To find the best image resolution for your purposes, make test prints of some raster 
artwork at different resolutions. Start with a high-resolution image (400 ppi) and save 
versions at progressively lower resolutions, down to 100 ppi, using a pixel-editing 
application, such as Photoshop. Always save a copy of the original high-resolution 
version, in case you must revert to it. The high-resolution data cannot be recreated 
from a lower resolution version. 

Print the files and examine the output. You will likely begin to see a marked 
deterioration in output quality at resolutions below 200 ppi, while above 200 ppi the 
improvement may be very subtle. 

Raster images prepared for offset printing may need to be at higher resolutions than 
necessary for proofing on your Color Server.

Image quality

Image resolution

100 ppi 200 ppi 300 ppi 400 ppi 500 ppi 600 ppi
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Scaling
Ideally, each raster image should be saved at the actual size, and it will be placed in the 
document at the optimal resolution for the printer. If the image resolution is correct 
for the printer, there is no quality advantage to be gained by scaling an image to a 
percentage of its actual size. If you scale a large image to a percentage of its actual size, 
you incur unnecessary file transfer time, because the image data for the entire large 
image is sent to the printer. If an image is placed multiple times at markedly different 
sizes in a document, save a separate version of the image at the correct size for each 
placement.

If you need to place an image at greater than 100% in a document, remember that the 
output image resolution is affected. For example, if you scale a 200 ppi image to 
200%, the image is printed at 100 ppi.



Glossary

additive color model
A system in which colors are produced 
by combining red, green, and blue light 
(the additive primaries). An RGB video 
monitor is based on an additive color 
model.

additive primaries
Red, green, and blue light used in 
additive color systems. When blended 
together in proper amounts, these colors 
of light produce white. 

artifact
A visible defect in an image, usually 
caused by limitations in the input or 
output process (hardware or software); 
a blemish or error.

banding
Visible steps between shades in a color 
gradient.

bit depth
Amount of information used for each 
pixel in a raster image. Black and white 
images require only one bit per pixel. 
Grayscale images with 256 shades of gray 
require 8 bits (or 1 byte) per pixel. 
Photographic quality color images can 
require 24 bits per pixel (RGB images) 
or 32 bits per pixel (CMYK images).

bitmap
An image comprised of small squares 
arranged in a grid. Each square in the 
grid is a pixel. The number of pixels per 
inch defines the resolution of a bitmap. 

blasting
An undesirable effect that occurs when 
excess amounts of toner, possibly 
combined with certain types of paper 
stock, cause objects in an image to 
spread beyond the boundaries defined 
in the file.

BMP
A graphics file format established by 
Microsoft; native to the Windows 
operating system.

calibration
The process of ensuring that a device 
behaves consistently with respect to a set 
of specifications. 

CMS
See color management system.

CMYK
A subtractive color model that uses cyan, 
magenta, yellow, and black, or process 
colors, used in color printing; a color 
model used in the printing of colors in 
four-color process printing.

color channel
A single-color image that can be edited 
separately from the other color channels 
comprising a color space—for example, 
the red channel of an RGB image.

color gamut
See gamut.
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color management system (CMS)
System used to match color across 
different input, display, and output 
devices. 

color rendering dictionary 
See CRD (Color Rendering Dictionary).

color separation
The process of separating a color image 
into the color components for 
printing—cyan, magenta, yellow, and 
black. Also used to refer to the four 
sheets of film that result from the process 
of separating a color image. 

color space
A model for representing color in terms 
of measurable values, such as the amount 
of red, green, and blue in an image. RGB 
and CMYK color spaces correspond to 
color devices—monitors and printers, 
respectively. Other color spaces, such as 
CIE Lab, are based on mathematical 
models and are device-independent (that 
is, not based on the color response of a 
particular device). See gamut.

colorant
An ink, dye, toner, paint, or other 
pigment that modifies the color of media 
to which it is applied.

ColorWise color management
An ICC-open color management 
solution, which is an easy-to-use system 
that addresses the needs of both casual 
and experienced color management 
users.

composite printer
Any output device that can print directly 
in color without first creating color 
separations. A composite print can be 
used as an early proof of an offset 
print job.

continuous tone (contone)
Describes a photographic image that 
contains gradient tones from black to 
white (such as a 35mm transparency or a 
photograph). Continuous tones cannot 
be reproduced in that form for printing, 
but must be screened to translate the 
image into dots.

continuous tone (contone) image
An image containing fine gradations of 
tones, such as a photographic image. 

CRD (Color Rendering Dictionary)
A feature of color management systems 
and PostScript Level 2 and PostScript 3 
color devices that maintains the best 
possible translation of color from one 
color device to another. A color 
rendering dictionary (CRD) is used by 
the color management system or the 
device’s PostScript interpreter when 
converting data between color spaces. 
The Color Server includes several CRDs, 
each of which provides a different color 
rendering style.

custom color system
A system of named color swatches that 
can be matched on press using process or 
spot colors. PANTONE and TruMatch 
are examples of custom color systems.
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DCS (Desktop Color Separation)
A data file standard defined by Quark, 
Inc., to assist in making color separations 
with desktop publishing systems; five 
files are created—four color files (one 
each for C, M, Y, and K) and a 
composite color preview file of the color 
image. It allows an image-editing 
application to perform color separation 
and pass it through to final output with 
its integrity intact.

densitometer
An instrument commonly used in the 
graphic arts industry to measure density 
according to a specified standard. 

density
A measurement of the light-absorbing 
quality of a photographic or printed 
image.

desktop color separation
See DCS.

DIC
A Japanese standard of specifications for 
separations, proofs, and color printing. 

EPS (or EPSF)
See Encapsulated PostScript.

Encapsulated PostScript
A PostScript file format designed to be 
embedded in another PostScript stream.

Euroscale
A European standard of specifications 
for separations, proofs, and color 
printing.

flexography
A printing technology that uses flexible 
raised-image plates. Flexography can be 
used to print on non-flat materials such 
as cans.

four-color printer
A printing device that uses cyan, 
magenta, yellow, and black ink or toner.

gamma
A numeric value representing the 
relationship (gamma curve) between the 
input and output values of a color 
device. If gamma equals 1, input values 
are mapped exactly to output values.

gamut
A range of colors. A device gamut is the 
range of colors that a device, such as a 
device, can produce. An image gamut is 
the range of colors in a particular image.

gamut mapping
The conversion of color coordinates 
from one device’s gamut to another—
usually accomplished with algorithms or 
look-up tables.

GDI (Graphics Device Interface)
Graphics and display technology used by 
computers running Windows. GDI 
applications rely on GDI (rather than 
the PostScript language) to send text and 
pictures to devices.
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GIF (Graphics Interchange Format)
A standard developed by CompuServe 
for bitmap graphics of up to 256 colors 
and used for posting photographic 
images on the Internet or intranet pages; 
rarely used for professional printing.

gradient
A smooth transition between two 
different colors or two shades of a color.

Graphics Device Interface
See GDI.

Graphics Interchange Format
See GIF.

gravure
A printing technology that uses an 
etched cylinder that has been immersed 
in ink. The ink that remains in the 
etched areas is applied to the paper. The 
non-etched surfaces of the cylinder are 
non-printing areas. 

gray component replacement (GCR)
In shadow, midtone, and quarter-tone 
areas where all three process colors 
(C, M, Y) overprint, the gray 
components of those colors are 
reduced and replaced by black. This 
improves wet ink trapping and reduces 
ink costs in process color printing.

halftoning
A method for representing an original 
continuous tone image using a pattern of 
dots, lines, or other patterns. 

HSB
A color model where each color is 
represented by its hue, saturation, and 
brightness components; supported by 
most color applications.

ICC profile
An industry standard color profile 
format developed by the International 
Color Consortium (ICC) that describes 
the color capabilities, including the 
gamut, of a color device based on the 
differences between an ideal and the 
current device. The ideal is often 
provided by the manufacturer as a color 
reference file. ICC profiles are 
implemented on Mac OS computers in 
ColorSync and on Windows computers 
in Image Color Matching (ICM). The 
Color Server color management system, 
ColorWise, supports ICC profiles.

imagesetter
Raster-based film output device; a high-
resolution laser output device that writes 
bitmapped data onto photosensitive 
paper or film.

JPEG
A graphics file format defined by the 
Joint Photographic Experts Group 
committee of International Standards 
Organization (ISO); a standard for 
digital compression of still image graphic 
data.
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metamerism
Phenomenon in which two colors 
composed of different combinations of 
light wavelengths appear identical under 
a specific light source, but may look 
different under other light sources. The 
colors are called “metamers.”

moiré
An undesirable pattern in images made 
using halftone screens. Moiré can be 
caused by the improper line frequency of 
the screens, improper screen angles, 
improper alignment of halftone screens, 
or by the combination of a halftone 
screen with patterns in the image itself.

named color
A color that is defined according to a 
custom color system. For example, 
PANTONE 107 C is a named color.

office applications
Software applications commonly used 
for business purposes, including 
presentation applications, spreadsheets, 
and word processing programs. 

offset lithography
Printing in which ink is transferred from 
printing plates to a rubber blanket and 
then from the blanket to paper.

output profile
The output profile describes the color 
characteristics of a printing device. It 
consists of both a profile for your device 
and a calibration target that defines the 
expected density response of the device. 

phosphor
Material used in making computer 
monitors; phosphors glow and emit red, 
green, and blue light when struck by an 
electron beam, thus creating an image.

photographic rendering
A color rendering style that preserves 
tonal relationships in images. 
Unprintable colors are mapped to 
printable colors in a way that retains 
differences in lightness, sacrificing color 
accuracy as necessary.

pixel
The smallest distinct element of a raster 
image. The term is a combination of the 
words “picture” and “element.”

PostScript
A device-independent page description 
language developed by Adobe, which is 
used to print and display pictures and 
text. PostScript 3 includes many 
enhancements to older versions of 
PostScript, including improved image 
quality and color with Enhanced Image 
Technology, faster performance with 
Advanced Page Processing, and ease of 
use and setup with NetWorks System.

PPD (PostScript Printer Description 
file)
A file containing information about a 
particular PostScript print device’s 
capabilities and restrictions. The 
information in the PPD is presented 
via the printer driver.
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prepress proof
A print made from a set of film 
separations or other file to simulate the 
results of printing. A prepress proof is 
the last opportunity to catch problems 
before the print job goes to press.

presentation graphics rendering
A color rendering style that creates 
saturated colors but does not match 
printed colors precisely to displayed 
colors. It is appropriate for bright 
saturated colors used in illustrations 
and graphs.

process colors
The  colors used in printing to simulate 
full-spectrum color images: Cyan, 
Magenta, Yellow, blacK (CMYK).

QuickDraw
Graphics and display technology built 
into Mac OS computers. QuickDraw 
applications rely on QuickDraw (rather 
than the PostScript language) to send 
text and pictures to devices.

raster image
Electronic representation of a page or 
image using a grid of points called pixels. 

rendering intent
The style of color rendering, or gamut 
mapping, designed for a particular type 
of color job. An example of a rendering 
intent is Photographic rendering—also 
referred to as Image rendering or 
Contrast rendering—which is designed 
for photographic images.

resolution
The number of pixels per inch (ppi) in a 
bitmap image or the number of dots per 
inch (dpi) that a device can render. 

RGB
An additive color model that makes a 
range of colors by combining red, green, 
and blue light, called the additive 
primaries. Commonly used to refer to 
the color space, mixing system, or 
monitor in color computer graphics.

simulation profile
The simulation profile describes the 
color characteristics of another print 
device, such as a printing press, that you 
want the Color Server to simulate. 

solid color rendering
A color rendering style intended for 
use when color accuracy is crucial. 
Unprintable colors are mapped to the 
closest printable colors. Solid color 
rendering does the best job of preserving 
the saturation of displayed colors.

source color space
The color environment of the 
originating source of an image, including 
scanners and color monitors. 

source profile
A profile used by the color management 
system to determine the characteristics of 
the color values specified in a source 
digital image.
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spectral light
The wavelengths of electromagnetic 
radiation emitted by a given light source 
that can be seen by the human eye. 

spectrophotometer
An instrument commonly used in the 
graphic arts industry to measure spectral 
light according to a specified standard.

spot color
A color that is printed on its own 
separation plate when separations are 
specified. A spot color is printed using a 
custom ink for that color, in contrast to 
process colors that are printed using 
combinations of cyan, magenta, yellow,  
and black. 

Spot Color Matching
See spot color.

subtractive color model
A system in which color is produced by 
combining colorants such as paint, inks, 
or dyes on media such as paper, acetate, 
or transparent film. All printing devices 
use the subtractive color model.

subtractive primaries
Cyan, magenta, and yellow colorants 
used in subtractive color systems for 
color printing. Combining the 
subtractive primaries produces darker 
colors. Black is added to the subtractive 
primaries to compensate for deficiencies 
of the toners or inks, and for more 
efficient black printing.

substrate
In printing, the material upon which the 
job is printed.

SWOP
The abbreviation for Specifications for 
Web Offset Publications. A standard of 
specifications for separations, proofs, and 
color printing on a web offset press (not a 
sheet fed press).

undercolor removal
In shadow areas where all three process 
colors (C, M, Y) overprint, the amounts 
of those colors are reduced and replaced 
by black. This improves wet ink trapping 
and reduces ink costs in process color 
printing.

vector graphic
Graphic illustration created on 
computers where picture objects are 
defined mathematically as lines or curves 
between points. These mathematical 
definitions are interpreted by an image 
language such as PostScript. Vector 
images include artwork created with 
illustration applications (such as 
Illustrator or FreeHand) and page layout 
applications (such as PageMaker). 

white point
The color temperature of any white light 
source, typically expressed in degrees 
Kelvin (for example, 6500 K, typical for 
the white of a monitor).
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workflow
The path a print job follows from 
creation to destination. A workflow may 
originate with an RGB scan imported to 
the client workstation and opened on the 
desktop in an image processing 
application, such as Photoshop. After 
adjustments are made to the scanned 
image, it is evaluated on a color proofing 
device for eventual color printing on the 
same device or on press.
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text A-13
theory A-1
triads A-12
using effectively A-10 to A-14
wheel A-11
working with 2-1

color management
basics xi to xv
ColorWise 1-2

color management system (CMS) xi
color matching systems, see custom color 

systems
color monitors, see monitors
color space A-3
color theory A-1
color wheel A-11
ColorSync xi
ColorWise xi
Commission Internationale de l’Eclairage, 

see CIE
complements, color A-12
compression, JPEG 4-11, 4-14, 4-15



I-2 Index
computer monitors, see monitors
continuous tone devices A-10
CorelDRAW 6-13 to 6-16
CRDs

bypassing 3-2, 5-2, 6-2
rendering intent 2-3

custom color systems 2-5, A-13

D
device profiles xi

E
EFICOLOR

profiles 5-12
XTension 5-12

EPS (Encapsulated PostScript)
recommended for imported 

images 3-1, 4-9, 5-2, 6-1, 6-2, 6-8, 
6-12, 6-16

Excel, see Microsoft Office

F
file size, of raster images 1-3, A-16
flexography A-9
font size, for color text A-14
FreeHand 2-5, 6-9 to 6-12

G
gamma xv
gamut

of monitors xiv
of photographic transparencies xiv

gamut mapping xiv
GDI applications, using color in 2-3 to 2-5
Graphics Device Interface, see GDI
graphs, using color in A-11
gravure A-9

H
halftoning A-9
HSB color model 2-5, A-4
HSL color model 2-3, 2-5

HSV color model 2-3
hue, saturation, and brightness A-1, A-4

I
ICC profiles

assigning to RGB images 6-2
included with user software xv
workflow 1-14

ICC standard for color management 
systems xi

illustration applications 6-1
Illustrator 2-5, 6-3 to 6-9
Image Color Matching xi
InDesign 5-3 to 5-7
ink xiii
International Color Consortium xi

J
JPEG 4-11, 4-14, 4-15

L
light A-1 to A-4
line art, see vector images

M
Macromedia FreeHand, see FreeHand
maintenance of print devices xiii
metamerism A-3
Microsoft Excel, see Microsoft Office
Microsoft Office 3-1 to 3-2
Microsoft PowerPoint, see Microsoft Office
Microsoft Word, see Microsoft Office
misregistration of colors A-14
moiré A-9
monitors

calibration xii
color model A-6
gamut of xiv
phosphors A-6

N
named colors 2-5



I-3 Index
O
office applications 2-1, 2-3 to 2-5, 

3-1 to 3-2
offset lithographic printing A-9
offset press print jobs, workflow issues 2-2
offset press printing A-9 to A-10
output profile

color conversion xv

P
page layout applications 5-1
PageMaker 2-5, 5-7 to ??
painting applications A-14
PANTONE

color system 2-5, 2-6
PANTONE Coated Color Reference 2-2
paper stock xiii
phosphors xv, A-6
photographic prints A-7
photographic transparencies xiv, A-7
Photoshop 2-5, 4-1 to 4-16
physics of color A-1
pixel-editing applications A-14, A-17
pixels in raster images A-14
PostScript applications

color handling 2-5
using color in 2-5 to 2-8

PostScript printer drivers 3-2
PowerPoint, see Microsoft Office
PPD G-5
prepress proof A-9
presentation print jobs

using color in A-11
press simulation, see CMYK Simulation 

option
print devices

maintenance xiii
printing test prints xiii

printing
raster images A-15
techniques A-9

prism A-2
process colors 2-7, A-7, A-9, A-10
profiles, device xi
proofing

prepress A-9

Q
QuarkXPress 2-5, 5-10 to 5-14
QuickDraw applications, using color in

2-3 to 2-5

R
raster images A-14 to A-17

bit depth A-15, A-16
file size A-16
for offset press printing A-17
printing A-15
resolution A-16 to A-17
scaling of A-18

registration of colors A-14
rendering styles 2-3
resident calibration xiii
RGB color model 2-3, 2-5
RGB Color Reference 2-2, 2-4
RGB source color space, see source color 

space

S
saturation A-1, A-4
scaling of raster images A-18
scanners A-5, A-6
screens, used in halftoning A-9
short-run color jobs, workflow issues 2-2
short-run color printing 1-1
simulation, see CMYK Simulation option
source color space xv
source color space profile

color conversion xv
spectral colors A-3
spectral components of light A-2, A-3
split complements A-12
Spot Color Matching option 2-8



I-4 Index
spot colors 2-5, 2-6, A-10
subtractive color model A-5, A-7
subtractive primaries A-7
sunlight A-1
swatch color matching 2-6

T
test prints xiii
text

font size A-14
using color with A-13

TIFF images
assigning ICC profiles to 5-2
preview 4-11
printing at full resolution 5-9
recommended for imported 

images 4-9, 5-2
RGB 6-2

tint A-4
toner xiii
transparencies (photographic) xiv, A-7
triads A-12

V
vector images A-14, A-15
visible spectrum of light A-1

W
white point xv
Windows Graphics Device Interface, see GDI 

applications
Word, see Microsoft Office
workflow

advanced 1-8
color proofing 1-1
ICC profiles 1-14
short-run jobs 1-1
simple 1-3
with Illustrator 1-10
with Photoshop 1-8, 1-16


	Introduction
	Basics of color management
	Controlling printed color
	Maintaining printer consistency
	Printer gamut
	Color conversion


	Chapter 1: Simple and Advanced Workflows
	Workflow concepts
	Short-run printing versus color proofing
	RGB, CMYK, and spot colors
	Desktop versus ColorWise color management

	Simple workflows
	Select your colors wisely
	Select a short workflow

	Advanced workflows
	Short-run printing examples
	Color proofing examples


	Chapter 2: Working with Color in Applications
	Working with color
	Color reference pages

	Office applications
	Choosing colors in office applications

	PostScript applications
	Choosing colors in PostScript applications
	Default output profile
	CMYK simulation


	Chapter 3: Office Applications
	Working with office applications
	Defining colors
	Working with imported files
	Selecting options when printing
	Output profiles


	Chapter 4: Adobe Photoshop
	Creating a monitor profile
	Specifying color settings
	Photoshop 6.x color settings
	Photoshop 5.x color settings

	Saving files
	Saving files from Photoshop 6.x or 5.x
	Advanced tips for using PostScript color management

	Defining colors
	Selecting options when printing
	Advanced tips for printing with Photoshop PostScript color�management


	Chapter 5: Page�Layout Applications
	Working with page layout applications
	Defining colors
	Importing images
	CMYK simulation

	Adobe InDesign 1.5.2
	InDesign color settings
	Importing images
	Selecting options when printing

	Adobe PageMaker 7.x and 6.5 for Mac�OS and Windows
	PageMaker color settings
	Windows version requirement
	Importing images
	Selecting options when printing
	Optional Color Management from PageMaker

	QuarkXPress 4.x for Mac�OS and Windows
	Importing images
	Selecting options when printing
	Optional Color Management from QuarkXPress

	QuarkXPress 3.32 for Mac�OS and Windows
	Windows version requirement
	Importing images
	Selecting options when printing


	Chapter 6: Illustration Applications
	Working with illustration applications
	Defining colors
	Importing images
	CMYK simulation

	Adobe Illustrator for Windows and Mac�OS
	Illustrator 9.x color settings
	Specifying print options
	Illustrator 8.x color settings
	Specifying print options
	Saving files for importing into other documents

	FreeHand 9.x and 8.x for Windows and Mac�OS
	FreeHand color settings
	Defining colors
	Importing images
	Saving files for importing into other documents
	Optional color management in FreeHand

	CorelDRAW for Windows and Mac�OS
	Defining colors
	Importing images
	Specifying print options
	Saving files for importing into other documents
	Optional color management in CorelDRAW


	Appendix A: Desktop Color�Primer
	The properties of color
	The physics of color
	CIE color model
	Hue, saturation, and brightness
	Additive and subtractive color systems

	Printing techniques
	Halftone and continuous tone devices

	Using color effectively
	A few rules of thumb
	Color wheel
	Color and text

	Raster images and vector images
	Optimizing files for processing and printing
	Resolution of raster images
	Scaling


	Glossary
	Bibliography
	Index

